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บทนํา 
 ในปจจุบัน  อุปกรณ ไมโครคอนโทรลเลอรไดพัฒนาไปเร็วมากดังจะเห็นไดจากการที่ มีไมโคร
คอนโทรลเลอรหลายตระกูลออกมาวางขายในทองตลาด และผูผลิตไมโครคอนโทรลเลอรเหลานี้ตางก็ได
พยายามพัฒนาขีดความสามารถในการทํางานของไมโครคอนโทรลเลอรของตนเองใหมีมากขึ้น ทั้งในดานการ
เพิ่มความเร็วของ CPU การเพิ่มฟงกชั่นการทํางานภายในใหมีมากขึ้น ในขณะที่ไมโครคอนโทรลเลอรบางเบอร
จะถูกออกแบบมาเพื่อใหผูใชงานสามารถเขียนโปรแกรมไดงายขึ้นดวย ซึ่ง AVR ไมโครคอนโทรลเลอรก็เปน CPU 
อีกตระกูลหนึ่งที่เปนที่นิยมนํามาใชงานในปจจุบัน เพราะมันเปนไมโครคอนโทรลเลอรที่มีทั้งความเร็วและการ
ออกแบบโครงสรางภายในที่เปนระเบียบทําใหผูใชงานสามารถเขียนโปรแกรมไดงาย 
 ทางบริษัท อีทีที จํากัด ไดออกแบบบอรด AVR ไมโครคอนโทรลเลอรขึ้นมาใหม 3 รุนดวยกันซึ่ง
ประกอบไปดวย  CP-AVR V3.0, CP-AVR V3.0 EXP และ  CP-AVR V4.0 ซึ่งรายละเอียดของบอรดไมโคร
คอนโทรลเลอรแตละรุนทานสามารถศึกษาไดจากเนื้อหาภายในของคูมือเลมนี้ โดยบอรดไมโครคอนโทรลเลอร 
ทั้ง 3 รุนนี้สามารถใชไดกับ AVR ไมโครคอนโทรลเลอรเบอร AT90S8535 หรือ ATmega163 หรือเบอรอื่น ที่มี
ตําแหนงขาของอุปกรณที่ตรงกันเชนเบอร ATmega323 เปนตน  

ในการพัฒนาโปรแกรมสําหรับผูเริ่มตนนั้น ทานสามารถศึกษาโปรแกรมตัวอยางไดจากแผน CD-ROM 
ที่ทานจะไดรับเมื่อทานซื้อบอรด AVR ไมโครคอนโทรลเลอร ซึ่งโปรแกรมตัวอยางเหลานี้จะถูกเขียนขึ้นดวยภาษา
แอสเซมบลีโดยใชโปรแกรม Astudio4 และเขียนดวยภาษาเบสิกโดยใชโปรแกรม BASCOM นอกจากนั้นแลวใน
แผน CD-ROM นี้ยังบรรจุโปรแกรม ASSEMBLER โปรแกรมสําหรับดาวนโหลดขอมูล Datasheet และโปรแกรม
อื่นๆ ที่จําเปนตอการพัฒนางานของทานไวดวย 
    
        พฤศจิกายน 2002 
        ทีมงาน อีทีที 
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สารบัญ 
เรื่อง          หนา 

- ลักษณะโดยทั่วไป         1 
- แหลงจายไฟ          1 
- การใชงานพอรตของ CPU เปน I/O Port (Input/Output Port)     5 
- การใชงานขั้วตอ PB(KBI)         6 
- การใชงานขั้วตอ PA(ADC)         7 
- การใชงานขั้วตอ I2C IN/OUT        7 
- การใชงานขั้วตอ I2C BUS EXPAND        8 
- การใชงานเครื่องอานบัตรแถบแมเหล็ก (MAGNETIC-CARD READER)    8 
- การใชงาน OUTPUT RELAY        9 
- การใชงานลําโพงขนาดเล็ก หรือ BUZZER       10 
- การใชงานจอแสดงผลแบบ LCD (Dot-Matrix Character LCD)     10 
- การเชื่อมตอกับอุปกรณ I2C BUS        12 
- การใชงาน Interrupt ของอุปกรณ I2C       13 
- แอดเดรสของอุปกรณ I2C         13 
- การใชงาน I2C RTC เบอร PCF8583        14 
- การใชงานหนวยความจํา EEPROM (24XX)       16 
- การใชงาน I/O Port แบบ I2C (PCF8574/A)       17 
- การใชงานพอรตส่ือสารอนุกรม SPI/RS232/RS422/RS485     19 
- การสื่อสารอนุกรม SPI         19 
- การสื่อสารอนุกรมแบบ RS232        20 
- การสื่อสารอนุกรมแบบ RS422        22 
- การสื่อสารอนุกรมแบบ RS485         23 
- การกําหนด Jumper สําหรับการสื่อสารแบบ RS422/485     24 
- การใชงานโปรแกรม w95s8535v5 และ w95mega163v1 สําหรับดาวนโหลดขอมูล   26 
- แนะนําการใชโปรแกรม Astudio4 (AVR assembler)      30 
- วงจรของบอรด CP-AVR V3        36 
- วงจรของบอรด CP-AVR V4        37 
- วงจรของบอรด CP-AVR V4 ตอ        38 
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CP-AVR 
ลักษณะโดยทั่วไป 
 บอรดไมโครคอนโทรลเลอร CP-AVR รุน CP-AVR V3.0, CP-AVR V3.0 EXP และ CP-AVR V4.0 
สามารถใชไดกับไมโครคอนโทรลเลอรตระกูล AVR เบอร AT90S8535 และ ATmega163 โดยจะทํางานที่
ความถี่สูงสุด 8 MHz ลักษณะของบอรดไมโครคอนโทรลเลอรในกลุม CP-AVR นี้ จะแบงออกเปน 3 รุน ใหผูใช
ไดเลือกใชงานกันตามความเหมาะสมดังนี้คือ 

- CP-AVR V3.0 เปนบอรดไมโครคอนโทรลเลอร ซึ่งออกแบบวงจรเฉพาะสวนพื้นฐานที่จําเปน เชน 
แหลงจายไฟ วงจรรีเซ็ต วงจรกําเนิดความถี่สัญญาณนาฬิกา วงจรสําหรับ Download โปรแกรม 
และวงจรสื่อสารอนุกรม สวนวงจร I/O ภายนอกนั้น จะไมไดจัดเตรียมไวใหดวย แตจะทําการตอ
สัญญาณ I/O ตางๆจาก CPU มาไวยังขั้วตอ Connector สําหรับใหผูใชนําไปเชื่อมตอกับอุปกรณ 
I/O ภายนอกไดโดยงาย และยังมีพื้นที่เอนกประสงคสําหรับใหผูใชออกแบบวงจร I/O และตอวงจร 
I/O เพิ่มเติมไดเอง เหมาะสําหรับผูใชที่ตองการนําบอรดไปใชพัฒนางานตนแบบโดยการสราง I/O 
ตางๆขึ้นมาใชงานเอง 

- CP-AVR V3.0 EXPANSION จะมีลักษณะเดียวกันกับบอรด CP-AVR V3.0 แตจะมีแผง Photo 
Board สําหรับใหผูใชตอทดลองวงจร I/O อยางงายๆไดเอง เหมาะสําหรับผูใชที่ตองการศึกษา
เรียนรูและตองการทดลองวงจร I/O ตางๆ รวมกับ CPU อยางงายๆ 

- CP-AVR V4.0 เปนบอรดไมโครคอนโทรลเลอรที่มีการออกแบบวงจรสําหรับเชื่อมตอกับอุปกรณ 
I/O ภายนอกอื่นๆที่มีความจําเปนไวรองรับการใชงานในลักษณะตางๆ เพื่อใหผูใชงานสามารถนํา
บอรดไปใชงานในลักษณะงานที่แตกตางกันได โดยไมตองดัดแปลงวงจร หรือ อาจดัดแปลงวงจร
เพียงเล็กนอยสําหรับงานบางอยาง ซึ่งบอรดรุนนี้เหมาะสําหรับกลุมผูที่ตองการนํา บอรดไมโคร
คอนโทรลเลอรไปใชงานจริงๆแตไมสะดวกที่จะสรางบอรดเอง 

 
แหลงจายไฟ (POWER SUPPLY) 
 สําหรับแหลงจายไฟของบอรดในกลุม CP-AVR นั้น จะสามารถตอใชงานไดทั้งกับไฟกระแสตรงและ
กระแสสลับ  เนื่ องจากในบอรดไดจัดเตรียมวงจร  RECTIFIER แบบ  BRIDGE พรอมวงจร FILTER และ 
REGULATOR ขนาด +5V ไวใหอยางครบถวนอยูแลว โดยผูใชสามารถปอนแรงดันไฟตรงหรือไฟสลับที่มีระดับ
แรงดันประมาณ 9-12V ใหกับบอรด โดยสามารถเลือกตอกับขั้ว CONNECTOR แบบ CPA ขนาด 2 ขา หรือจะ
ตอผานขั้ว CONNECTOR สําหรับ ADAPTER จายไฟก็ไดเชนกัน โดยการทํางานของแหลงจายไฟจะมี LED 
“PWR” สําหรับแสดงผลการทํางานใหทราบดวย 
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            รูปแสดง บอรดไมโครคอนโทรลเลอรรุน CP-AVR V3 
 
 
 
 
 
 
 
 
 
 
   รูปแสดง บอรดไมโครคอนโทรลเลอรรุน CP-AVR V3 EXP 

 
 
 
 
 
 
 
 
 
 

 
     รูปแสดง บอรดไมโครคอนโทรลเลอรรุน CP-AVR V4 
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รูปแสดง ลักษณะของบอรด CP-AVR V3 / AVR V3 EXP 
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      รูปแสดง ลักษณะของบอรด CP-AVR V4 
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การใชงานพอรตของ CPU เปน I/O Port (Input/Output Port) 
 ลักษณะการตอขาพอรตของไมโครคอนโทรลเลอร (MCU) เขากับพอรต I/O ขนาด 34 
ขา(72IOZ80)สามารถแสดงไดดังรูปตอไปนี้ ซึ่งบอรดทั้งสามรุนจะตอในรูปแบบเดียวกัน 
     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว 34PIN 
 

 โดยปกติพอรต I/O ของ AVR สามารถรับกระแส sink ไดประมาณ 20 mA ดังนั้นเราจึงสามารถนํา
พอรตเหลานี้ไปขับ LED ใหทํางานได ในการใชงานพอรตของ AVR เปน Input/Output Port เราจะตองทําการ
กําหนดทิศทางของพอรตวาจะใหเปนอินพุตหรือเปนเอาพุตโดยการเซตหรือเคลียรคาในรีจิสเตอร DDRx และถา
เราตองการกําหนดระดับของสัญญาณ(high/low)ในขณะที่ PORTx ทํางานในโหมด output เราก็สามารถทําได
โดยการไปset หรือ clear คาในรีจิสเตอร PORTx สวนในกรณีที่พอรตทํางานในโหมด input นั้นถาหากเรามีการ
ตอ R pull low ภายนอกไว และทําการ Set พอรตที่ตอ R Pull Low ใหเปน 1 (Enable Internal Pull Up) พอรต
นั้นจะสามารถจายกระแสออกมาใหกับR ที่ตอ Pull Low ภายนอกไดดวยกระแสประมาณ 20 mA  

ในการอานคาของสัญญานจากภายนอกนั้น ถาเราอานจากรีจิสเตอร PORTx เราจะไดคาที่ถูก Latch  
คางไว ซึ่งเปนคาที่เกิดกอนหนาที่เราจะทําการอาน แตถาเราอานจากรีจิสเตอร PINx เราจะไดคาที่เปนจริงที่เกิด
ขึ้นที่ขาพอรตขณะที่เราทําการอาน ตารางตอไปนี้จะเปนรูปแบบการกําหนดคาเพื่อใหพอรตทํางานในโหมด I/O  

 

PB0
PB2
PB4

PB6
PA0
PA2
PA4
PA6
PC0
PC2
PC4
PC6
+5V
GND
PD2
PD4
PD6

PB1
PB3
PB5
PB7
PA1
PA3
PA5
PA7
PC1
PC3
PC5
PC7
NC
RES
PD3
PD5
PD7
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DDxn PORTxn I/O Pull up Comment 

0 0 Input No Tri-state (Hi-Z) 
0 1 Input Yes Pxn will source current if ext. pulled low 
1 0 Output No Push-Pull Zero output 
1 1 Output No Push-Pull One output 

หมายเหตุ : x คือพอรต A – D, n คือบิต 0 – 7 
 
ตารางแสดง การกําหนดคาใหกับพอรตของไมโครคอนโทรลเลอรตระกูล AVR เพื่อเลือก
โหมดการทํางาน 
 
การใชงานขั้วตอ PB(KBI) 
 พอรต PB(KBI) ถูกจัดไวที่ขั้ว Connector ขนาด 10 PIN แบบ IDE ซึ่งขั้วตอนี้จะมีอยูเฉพาะ ในบอรด 
รุน CP-AVR V4.0 เทานั้น โดยขั้วตอนี้จะเชื่อมตอสัญญาณมาจาก PORTB ของ MCU ทั้ง 8 เสน โดย PB0-PB6 
จะถูกนํามาจัดเรียงไวโดยตรงอยูแลว สวน PB7 จะตองเลือกจาก Jumper (4x4/SPK)  อีกครั้งหนึ่ง โดยลักษณะ
ของขาสัญญาณที่จัดเรียงไวที่ขั้ว PB(KBI) จะเปนดังรูป 

 

 
 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว PB(KBI) 
 

 โดยจุดประสงคในการออกแบบของบอรด CP-AVR V4.0 นั้น ขั้วตอ PB(KBI) จะใชสําหรับใหผูใช
เชื่อมตอกับวงจรคียบอรดแบบ Matrix ซึ่งสามารถจะใชไดกับคียบอรดแบบ Matrix ขนาด 4x3 หรือ 4x4 ก็ได ซึ่ง
ในกรณีที่ใชกับคียบอรดขนาด 4x3 จะเหลือสัญญาณไว 1 เสนคือ PB7 ซึ่งสามารถนําไปใชควบคุมการกําเนิด
เสียงของลําโพงขนาดเล็กหรือ BUZZER เพื่อกําเนิดเสียงได 

สําหรับในกรณีที่ไมมีความจําเปนตองใชงานคียบอรดแลว ขั้วตอ PB(KBI) นี้ก็ยังสามารถนําไปตอใช
งานเปน Input หรือ Output ทั่วๆไปไดอีกดวย โดยจากวงจรทานจะพบวาเราไดตอ LED เขากับขา PB0 ดังนั้น
หากทานไมใชงานคียบอรดทานสามารถใชงาน LED TEST ตัวนี้ไดโดยการ Short Jumper PB0 สําหรับบอรดไม
โครคอนโทรลเลอร CP-AVR V3.0/V3.0 EXP หรือ Short Jumper PA0 สําหรับบอรดไมโครคอนโทรลเลอร CP-
AVR V4.0   

 

PB0
PB2
PB4
PB6

+VCC

PB1
PB3
PB5
PB7
GND



 
คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน CP-AVR V3.0/V3.0 EXP/V4.0 

ETT CO.,LTD. - 7 - WWW.ETT.CO.TH 

การใชงานขั้วตอ PA(ADC) 
 พอรต PA(ADC) นี้จะถูกเชื่อมตอออกมารอไวยังขั้ว Connector ขนาด 10 PIN แบบ IDE ซึ่งขั้วตอนี้จะ
มีอยูเฉพาะบอรดในรุน CP-AVR V4.0 เทานั้น โดยขั้วตอ PA(ADC) นี้ สามารถโปรแกรมหนาที่การใชงานได 
หลายหนาที่ เชน โปรแกรมใหทําหนาที่เปน ADC ขนาด 10 บิต 8 ชอง เพื่อรับคาสัญญาณ Analog ขนาด 0-
5VDC จากภายนอกเขามาและเปลี่ยนเปนคาขอมูลดิจิตอล (000H-3FFH) ใหกับ CPU นําไปประมวลผลตาม
ตองการ หรือถาไมตองการใชงานเปน ADC พอรต PA(ADC) นี้ก็ยังสามารถโปรแกรมหนาที่การทํางานสําหรับใช
งานเปน Input / Output ทั่วไปไดอีกดวย โดยลักษณะของขาสัญญาณที่จัดเรียงไวที่ขั้ว PA (ADC) จะเปนดังรูป 

 

 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว PA(ADC) 
 

นอกจากนี้แลวขา PA7 ในกรณีที่ไมตองการใชงานเปน ADC สามารถนําไปใชงานเปน Output สําหรับ
ควบคุมการทํางานของ RELAY ไดอีกดวย โดยการ Short Jumper PA7(RELAY) ไว 
 
การใชงานขั้วตอ I2C IN/OUT 
 พอรต I2C IN/OUT นี้จะถูกเชื่อมตอออกมารอไวยังขั้ว Connector ขนาด 10 PIN แบบ IDE ซึ่งขั้วตอนี้
จะมีอยูเฉพาะบอรดในรุน CP-AVR V4.0 เทานั้น โดยขั้วตอ I2C IN/OUT นี้ จะเชื่อมตอมาจากขาสัญญาณ I/O 
Port ของ PCF8574/A ซึ่งสามารถโปรแกรมหนาที่การใชงาน ใหเปน Input หรือ Output ก็ไดตามตองการจาก
โปรแกรม แตตองกําหนดหนาที่ใหเปน Input หรือ Output อยางใดอยางหนึ่งเทานั้น ไมสามารถใชงานทั้งสอง
หนาที่พรอมๆกันได และในการกําหนดหนาที่ใหเปน Input หรือ Output ก็ตองกําหนดใหเหมือนกันทั้ง 8 บิต ดวย 
โดยลักษณะของขาสัญญาณที่จัดเรียงไวที่ขั้ว I2C IN/OUT จะเปนดังรูป 

 

 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว I2C IN/OUT 
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คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน CP-AVR V3.0/V3.0 EXP/V4.0 

ETT CO.,LTD. - 8 - WWW.ETT.CO.TH 

การใชงานขั้วตอ I2C BUS EXPAND 
 พอรต I2C BUS EXPAND นี้จะถูกเชื่อมตอออกมารอไวยังขั้ว Connector ขนาด 10 PIN แบบ IDE ซึ่ง
ขั้วตอนี้จะมีอยูเฉพาะบอรดในรุน CP-AVR V4.0 เทานั้น โดยขั้วตอ I2C BUS EXPAND นี้ จะใชสําหรับทําการ
ขยายหรือเพิ่มเติมจํานวนอุปกรณที่ใชการติดตอส่ือสารแบบ I2C ใหกับบอรด  

 

 
 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว I2C BUS EXPAND 
 

การใชงานเครื่องอานบัตรแถบแมเหล็ก (MAGNETIC-CARD READER) 
 สําหรับบอรด CP-AVR V4.0 นั้น จะออกแบบใหสามารถเชื่อมตอกับเครื่องอานบัตรแถบแมเหล็กรุน 
“MCR-B02TTL” ไดโดยตรง โดยไมตองดัดแปลงวงจรใดๆทั้งส้ิน โดยในบอรดจะจัดเตรียมขั้วแบบ CPA ขนาด 5 
PIN ไวรองรับอยูแลว ผูใชสามารถนําขั้วตอของเครื่องอานบัตรแถบแมเหล็ก รุน “MCR-B02TTL” ของบริษัท อีที
ที ตอเขาไปไดทันที สําหรับในการเขียนโปรแกรมเพื่อเชื่อมตอระหวางบอรด CP-AVR V4.0 กับเครื่องอานบัตร
แถบแมเหล็กนั้น จะสามารถทําได 2 แบบ คือ ใชวิธีการวนรอบตรวจสอบสัญญาณจากเครื่องอานบัตรแถบแม
เหล็กเอง ซึ่งวิธีการนี้จะใชสัญญาณจาก CPU เพียง 2 เสนสัญญาณคือ PD4 ทําหนาที่เปน DATA และ PD5 ทํา
หนาที่เปน CLOCK โดยตองกําหนดคุณสมบัติของสัญญาณทั้ง 2 เสนใหมีทิศทางเปน Input และควร ENABLE 
การ PULL-UP ของสัญญาณทั้ง 2 นี้ดวยเสมอ สวนอีกวิธีหนึ่งคือการใชวิธีการ Interrupt ซึ่งสามารถทําไดโดย
การ SHORT JUMPER “INT1” ที่อยูใกลๆกับขั้วตอเครื่องอานบัตรแถบแมเหล็ก ซึ่งการ SHORT JUMPER จะ
เปนการเชื่อมตอสัญญาณ INT1 ของ CPU เขากับ สัญญาณ PRESENT ของเครื่องอานบัตรแถบแมเหล็ก ดังนั้น
เมื่อมีการนําบัตรแถบแมเหล็กไปรูดผานเครื่องอานบัตรแถบแมเหล็กก็จะมีการสงสัญญาณ Interrupt ออกมายัง 
CPU ซึ่งผูใชก็เพียงแตเขียนโปรแกรมสําหรับบริการการ Interrupt ของ INT1 ไวก็สามารถใชงานไดแลว 

 
 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้วตอ 
เครื่องอานบัตรแถบแมเหล็ก MCR-B02TTL 

+VCC
GND
GND
GND
GND

GND
PC0(SCL)

PC1(SDA)
I2CINT1

NC

PD4(DATA)

PD5(CLOCK)

PD3
(PRESENT)

+VCC

GND
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 ***หมายเหตุ*** เนื่องจากการเลือกใช Interrupt จากสัญญาณ INT1 ของ CPU นั้น ภายในบอรด รุน 
CP-AVR V4.0 สัญญาณ INT1 จะถูกออกแบบใหสามารถเลือกกําหนดใชงานรวมกับอุปกรณหลายๆตัว เชน 
การ Interrupt จากไอซีขยาย PORT I/O เบอร PCF8574/A และการ Interrupt จาก เครื่องอานบัตรแถบแมเหล็ก 
MCR-B02TTL ดังนั้นในกรณีที่ตองการเลือกใชวิธีการ Interrupt จาก INT1 นั้น จะตองทําการ OPEN JUMPER 
สําหรับเลือกการ Interrupt จากอุปกรณอื่นๆที่ไมเกี่ยวของออกเสียกอน ใหเหลือการเชื่อมตอสัญญาณ INT1 
จาก CPU กับอุปกรณเพียงตัวใดตัวหนึ่งเทานั้น เพื่อใหแนใจวาสัญญาณ Interrupt ที่เกิดขึ้นจะถูกสงมาออกมา
จากเครื่องอานบัตรแถบแมเหล็กเทานั้น ไมเชนนั้นแลวอาจเกิดความผิดพลาดขึ้นได 
 
การใชงาน OUTPUT RELAY 
 ภายในบอรด CP-AVR V4.0 นั้น จะออกแบบวงจรควบคุม  RELAY ไวใหผูใชงานสามารถนําไป
ประยุกตใชงานทั่วไปไดดวย จํานวน 1 ชุด โดยวงจร RELAY ดังกลาวสามารถใชงานได ทั้งหนาสัมผัสแบบปรกติ
เปด (Normal Open : NO) และแบบหนาสัมผัสปรกติปด (Normal Close : NC)  
 สําหรับสัญญาณ Output ในการควบคุมการทํางานของ RELAY นั้น จะแบงมาจาก PA7 ของ CPU ซึ่ง
เมื่อตองการใชงาน RELAY จะตองทําการ SHORT JUMPER PA7(RELAY) ไวดวยเพื่อเชื่อมตอสัญญาณ PA7 
มาทําการควบคุมการทํางานของ RELAY และตองแนใจวาไมไดตอสัญญาณ PA7 จากขั้วตออื่นๆออกไปใชงาน
กับอุปกรณใดๆนอกเหนือจาก RELAY เนื่องจากสัญญาณ PA7 นั้น นอกจากจะตอมาใชควบคุมการทํางานของ 
RELAY แลวยังตอไปยังขั้วตอ 34PIN และขั้วตอ PA(ADC) ดวย โดยการทํางานของ RELAY จะถูกควบคุมการ
ทํางานจากขาสัญญาณ PA7 ผูใชตองกําหนดคุณสมบัติของสัญญาณ PA7 ใหทําหนาที่เปน OUTPUT ซึ่งเมื่อขา
สัญญาณ  PA7 มีสภาวะเปน OUTPUT และใหสถานะเปน “1” จะทําให RELAY ทํางาน แตถาสถานะของ
สัญญาณ PA7 มีคาเปน “0” จะทําให RELAY หยุดทํางาน 

 

ปรกติเปด

จุดรวม

ปรกติปด

 
รูปแสดง ลักษณะขั้วตอสัญญาณจากหนาสัมผัสของ RELAY 

 
 

 ***หมายเหตุ*** เนื่องจากสัญญาณ PA7 ที่นํามาใชควบคุมการทํางานของ RELAY จะเปนสัญญาณ
เสนเดียวกับ PA7 ที่ตอไวยังขั้ว 34PIN และขั้วตอ 10PIN แบบ IDE ของพอรต PA(ADC) ดังนั้น เมื่อตองการใช
งาน RELAY โดยการควบคุมจาก PA7 แลว ตองแนใจวาไมไดตอใชงานสัญญาณ PA7 ในจุดอื่นๆดวย แตถา
หากมีความจําเปนตองใชงาน PA7 พรอมกับการใชงาน RELAY ดวยในเวลาเดียวกัน ก็อาจดัดแปลงวงจรไดโดย
การ OPEN JUMPER PA7(RELAY) ออก แลวใชวิธีการเชื่อมสายสัญญาณเสนอื่นๆจาก PORT I/Oของ CPU ที่
ไมไดใชงานมาเขากับวงจรควบคุม RELAY แทนก็ไดเชนเดียวกัน โดยใหเชื่อมตอสายสัญญาณที่ตองการไปยัง 
Jumper PA7(RELAY) ดานที่ตอกับตัวตานทานคา  1KOhm แตการดัดแปลงวิธีนี้ควรถอดตัว  JUMPER 
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PA7(RELAY) ออกจากบอรดเสียกอน เพื่อจะไดไมหลงลืมทําการ SHORT JUMPER นี้ซ้ําอีกในภายหลัง เนื่อง
จากจะเปนการ SHORT สัญญาณ PA7 เขากับสัญญาณเสนใหมที่บัดกรีมายังวงจร RELAY นี้อีก 
 
การใชงานลําโพงขนาดเล็ก หรือ BUZZER 
 ภายในบอรด CP-AVR V4.0 จะมีวงจรกําเนิดเสียงรวมอยูดวย 1 จุด ซึ่งในตําแหนงนี้สามารถเลือกใส
อุปกรณกําเนิดเสียงแบบลําโพงขนาดเล็ก หรือ จะเลือกใส BUZZER แทนก็ไดเชนเดียวกัน โดยในกรณีที่เลือกใช
ลําโพงจะมีขอดีคือ สามารถสรางความถี่เสียงไดหลากหลายความถี่ตามตองการแตการเขียนโปรแกรมจะยุงยาก
กวา BUZZER เนื่องจากตองสรางเปนสัญญาณความถี่จึงจะสามารถทําใหลําโพงกําเนิดเสียงใหได สวนในกรณี
ที่เลือกใช BUZZER นั้น จะมีขอดีคือ เขียนโปรแกรมควบคุมการกําเนิดเสียงไดงายกวาลําโพง เนื่องจากใชวิธีการ 
ON หรือ OFF เทานั้น โดยการ ON บิตควบคุม BUZZER ใหมีสภาวะเปน “1” เทานั้น BUZZER ก็จะกําเนิดเสียง
ใหแลว แตความถี่เสียงของ BUZZER จะไมสามรถเลือกได เหมือนกับลําโพง 
 สําหรับสัญญาณ Output ในการควบคุมการทํางานของ ลําโพง หรือ BUZZER นั้น จะแบงมาจาก PB7 
ของ CPU ซึ่งเมื่อตองการใชงาน ลําโพง หรือ BUZZER จะตองทําการเลือก JUMPER 4x4/SPK มารอไวยัง
ตําแหนง SPK ดวย เพื่อใหสามารถนําสัญญาณ PB7 มาทําการควบคุมการทํางานของลําโพง หรือ BUZZER ได 
โดยผูใชตองทําการกําหนดคุณสมบัติของสัญญาณ PB7 ใหทําหนาที่เปน OUTPUT ไวดวย ซึ่งเมื่อขาสัญญาณ 
PB7 มีสภาวะเปน OUTPUT และใหสถานะเปน “1” จะทําให ลําโพง หรือ BUZZER ทํางาน แตถาสถานะของ
สัญญาณ PB7 มีคาเปน “0” จะทําให ลําโพง หรือ BUZZER หยุดทํางาน 
 

***หมายเหตุ*** เนื่องจากสัญญาณ PB7 ที่นํามาใชควบคุมการทํางานของ ลําโพง หรือ BUZZER นั้น
จะเปนสัญญาณเสนเดียวกับ PB7 ที่ตอไวยังขั้ว 34PIN และขั้วตอ 10PIN แบบ IDE ของพอรต PB(KBI) ดวย ดัง
นั้นเมื่อตองการใชงานลําโพง หรือ BUZZER โดยการควบคุมจาก PB7 แลว ตองแนใจวาไมไดตอใชงาน
สัญญาณ PB7 ในจุดอื่นๆทั้งสอง ดังกลาวดวย แตถาหากมีความจําเปนตองใชงาน PB7 พรอมกับการใชงาน 
ลําโพง หรือ BUZZER ดวยในเวลาเดียวกัน ก็อาจดัดแปลงวงจรได โดยการใชวิธีการบัดกรีเชื่อมสายสัญญาณ
เสนอื่นๆจาก PORT I/Oของ CPU ที่ไมไดใชงานมาเขากับวงจรควบคุมลําโพงหรือ BUZZER แทนก็ไดเชนเดียว
กัน โดยใหเชื่อมตอสายสัญญาณที่ตองการไปยัง Jumper 4x4/SPK ดาน SPK แตการดัดแปลงวิธีนี้ควรถอดตัว 
JUMPER 4x4/SPK ออกจากบอรดเสียกอนแลวทําการเชื่อมตอขาสัญญาณ Jumper 4x4/SPK ดาน ตําแหนง 
4x4 ไวดวยกันเลย เพื่อจะไดไมหลงลืมทําการเลือก JUMPER กลับมายังดาน SPK นี้อีกในภายหลัง เนื่องจากจะ
เปนการ SHORT สัญญาณ PB7 เขากับสัญญาณเสนใหมที่บัดกรีมายังวงจรควบคุมลําโพงหรือ BUZZER นี้อีก 
 
การใชงานจอแสดงผลแบบ LCD (Dot-Matrix Character LCD) 
 บอรด CP-AVR V4.0 สามารถใชเชื่อมตอกับจอแสดงผล LCD แบบ Dot-Matrix โดยเชื่อมตอผานทาง 
Connector ขนาด 14 PIN และใชตัวตานทานปรับคาไดแบบเกือกมาขนาด 10K สําหรับปรับระดับความสวาง
ของหนาจอ LCD โดยวงจรในการเชื่อมตอ LCD ของบอรดนี้จะออกแบบวงจรใหใชวิธีการควบคุมการทํางาน
แบบ "DATA 4-BIT"  
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รูปแสดง ขาสัญญาณของขั้วตอ CLCD 
 

สําหรับวิธีการเชื่อมตอสัญญาณจากขั้วตอ CLCD ของบอรดไปเขากับตัว LCD นั้น เพื่อความสะดวก
ขอแนะนําใหใชสายแพร ขนาด 14 เสน เปนตัวเชื่อมตอสัญญาณระหวางบอรดและตัว LCD จะสะดวกมากที่สุด  
ซึ่งในปจจุบันพบวา ลักษณะขั้วสัญญาณที่อยูทางดานของจอแสดงผล LCD เองนั้น ที่พบเห็นไดทั่วๆไป จะมีอยู 
ดวยกัน 2 แบบ คือ 

- แบบที่เปนขั้วตอแบบแถวเดี่ยว ขนาด 14PIN (HEADER 14X1) โดยการตอสายของ LCD แบบนี้ 
จะใชสายแพรขนาด 14 เสน แบบเขาหัว CONNECTOR ไวดานเดียว สําหรับเสียบกับขั้วตอ 
CLCD ภายในบอรด CP-AVR V4.0 สวนปลายสายอีกดานหนึ่งของสายแพรทั้ง 14 เสน จะตองนํา
ไปบัดกรีเขากับขั้วตอของตัว LCD ใหครบทั้ง 14 เสน โดยในการบัดกรีจะตองสลับปลายสายเปน
คูๆเรียงลําดับกันไป คือ ขา 2 สลับกับ 1,ขา4 สลับกับ 3…ขา14 สลับกับ 13 ตามลําดับ กลาวคือ 
สายเสนที่1 ตอกับ PIN2 ของ LCD สวนสายเสนที่2 จะตองตอกับ PIN1 ของ LCD และในทํานอง
เดียวกันสายเสนที่3 ก็จะตองตอกับ PIN4 ของ LCD อยางนี้เรื่อยไปจนครบทั้ง 14 เสน 

- แบบที่เปนขั้วตอแบบแถวคู 14PIN (HEADER ขนาด 7X2) โดยการตอสายของ LCD แบบนี้ จะใช
สายแพรขนาด 14 เสน แบบเขาหัว CONNECTOR ไวทั้งสองดาน โดยในการเชื่อมตอนั้น ใหตอ
สายแตละดานเขากับขั้วตอ โดยใหตําแหนงของ PIN1 ของขั้วตอแตละดานอยูในตําแหนงที่ตรงกัน
ก็สามารถใชงานไดแลว 

 
 ***หมายเหตุ*** ใน CLCD บางรุนนั้น อาจมีขั้วตอสัญญาณเพิ่มเปน ขนาด 16 PIN ซึ่งในกรณีนี้ ก็จะ
ยังคงใชวิธีการเชื่อมตอแบบเดิม คือจะใชสัญญาณในการเชื่อมตอระหวาง CLCD กับบอรด เพียงแค 14 PIN เทา
นั้น สวนสัญญาณขา 15 และ 16 ที่เพิ่มเขามานั้นจะเปนขาไฟเลี้ยงของวงจร LED Back-Light (A และ K) ซึ่งถา 
LCD ที่ซื้อมาใชงานมี LED Back-Light รวมอยูดวย ขอแนะนําใหแยกตอไฟเลี้ยง LED Back-light เขากับแหลง
จายไฟ +5V โดยตรงตางหากก็ได หรือถาตองการให LED Back-Light ทํางานตลอดเวลาก็อาจทําการตอขา
สัญญาณ (A) หรือขา 15 เขากับ ขา 2 ของ LCD สวนขา (K) ก็ใหตอเขากับขา 1 ของ LCD ก็ไดเชนกัน 
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รูปแสดง วิธีการตอสาย LCD แบบใชขั้วแถวเดี่ยว 
 
การเชื่อมตอกับอุปกรณ I2C BUS 

สําหรับอุปกรณแบบ I2C Bus ที่ใชในบอรด CP-AVR V4.0 นั้น จะออกแบบใหสามารถติดตั้งใชงาน
อุปกรณ I2C ไดพรอมกันในบอรดทั้งหมดดวยกัน 3 ตัว คือ  

- I2C RTC  เบอร PCF8583 ของ PHILIPS  
- EEPROM ในตระกูล 24XX ซึ่งสามารถเลือกใชไดหลายเบอรหลายผูผลิต ขึ้นอยูกับขนาดความจุ

ของหนวยความจําที่ตองการจะใช  ซึ่งในบอรด CP-AVR V4.0 นั้น สามารถติดตั้งใชงานหนวย
ความจํา EEPROM แบบ I2C นี้ไดตั้งแต เบอร 24XX32,24XX64,24XX128,24XX256 หรือ 
24XX512 เปนตน 

- I2C I/O เบอร PCF8574 หรือ PCF8574A ของ Phillips 
โดยอุปกรณ I2C ทั้ง 3 ตัวนี้จะตอรวมกันอยูภายในบัสเดียวกัน และใชสัญญาณ PC1 เปนขาสัญญาณ 

SDA และใชสัญญาณ PC0 เปนสัญญาณ SCL ในการควบคุมบัส ซึ่ง CPU จะทําหนาที่เปนตัวแมในการควบคุม
บัส นอกจากนี้แลวยังสามารถขยายอุปกรณจําพวก I2C นี้ไดอีก แตตองเปนอุปกรณที่มีรหัสควบคุม Control 
Word ไมซ้ํากันกับอุปกรณที่มีอยูแลวภายในบอรดดวย โดยอาจเชื่อมตอผานทางขั้วตอ “I2C EXPANSION” ที่
บอรดจัดเตรียมไวใหแลวก็ได 

สําหรับในการใชงานอุปกรณ I2C นั้น เนื่องจาก CPU เบอร AT90S8535 ไมมีสวนของฮารดแวรที่ทํา
หนาที่ติดตอส่ือสารแบบ I2C บรรจุไวในตัว CPU ดวย ดังนั้นจึงตองใชวิธีการนํา I/O Port ของ CPU มาใชติดตอ
กับอุปกรณแบบ I2C แทน โดยกําหนดให 

- SDA ตอกับขา PC1 ทําหนาที่เปนสัญญาณขอมูลแบบ 2 ทิศทาง ใชสําหรับรับสงขอมูลจาก CPU 
กับอุปกรณ I2C โดยเมื่อ CPU ตองการเขียนขอมูลไปยังอุปกรณ ผูใชจะตองกําหนดใหสัญญาณนี้
ทําหนาที่เปน Output แตเมื่อ CPU ตองการอานหรือรับขอมูลจากอุปกรณ ผูใชก็ตองกําหนดให

จอแสดงผล Character LCD
แบบ Dot Matrix

ขา14 ขา1
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สัญญาณนี้ทําหนาที่เปน Input แทนและตองกําหนดการ Pull-Up ใหกับสัญญาณที่ทําหนาที่เปน 
SDA นี้ดวยเสมอ  

- SCL ตอกับขา PC0 ทําหนาที่เปนสัญญาณนาฬิกา Clock สําหรับใชติดตอส่ือสารกับอุปกรณ I2C 
สัญญาณ SCL นี้จะเปนสัญญาณ Output จาก CPU เพื่อใชควบคุมการรับสงขอมูลระหวาง CPU 
กับอุปกรณ  

สําหรับการใชงานฟงกชั่น I2C ใน CPU เบอร ATmega163 นั้นเราสามารถเลือกวิธีการติดตอส่ือสารขอ
มูลแบบการกําหนดใหพอรตทํางานเปน I/O ดังที่ไดอธิบายมาแลวในขางตนหรือจะเลือกใชฟงกชั่น 2-wire Serial 
Interface ที่มีอยูในตัวไอซีเบอรนี้ก็ได ซึ่งฟงกชั่นนี้จะเปนฟงกชั่นที่ใชสําหรับส่ือสารขอมูลในมาตรฐาน I2C โดย
เฉพาะ ทําใหเราสามารถเขียนโปรแกรมไดงายและมีประสิทธิภาพมากขึ้น  
 
การใชงาน Interrupt ของอุปกรณ I2C 

สําหรับในสวนของอุปกรณ I2C ที่อยูภายในบอรดนั้น จะมีอยู 2 อุปกรณดวยกัน ที่สามารถสราง
สัญญาณ Interrupt ใหกับ CPU ได คือ RTC เบอร PCF8583 และ I/O Port เบอร PCF8574/A ซึ่งในการเลือก 
Interrupt ใหกับอุปกรณทั้งสองนั้น ถาผูใชเลือก Short Jumper I/O INT1 จะเปนการตอขา INT(ขา 13) ของ 
PCF8574/A เขากับขา INT1 ของ CPU และในขณะเดียวกันสัญญาณ INT1 นี้ก็จะถูกตอผานไปยังขั้ว I2C BUS 
EXPAND ดวย และถาผูใชเลือก Short Jumper RTC INT0 จะเปนการตอขา INT(ขา 7) ของ PCF8583 เขากับ
ขา INT0 ของ CPU อยางไรก็ตามทั้งสัญญาณ INT0 และ INT1 ของ CPU นี้จะถูกตอโดยตรงเขากับขั้ว 34 Pin 
 
 ***หมายเหตุ*** ไมควรทําการ Short Jumper ของ INT0 หรือ INT1 เขากับอุปกรณมากกวา 1 
อุปกรณ เนื่องจากจะเปนการยุงยากในการเขียนโปรแกรมเพื่อตรวจสอบแหลงที่มาของการ Interrupt วามาจาก
อุปกรณตัวใด 

 
แอดเดรสของอุปกรณ I2C  
 เนื่องจากคุณสมบัติของ BUS แบบ I2C นั้น สามารถเชื่อมตออุปกรณตางๆที่ใชวิธีการสื่อสารแบบ  I2C 
ไดมากมากหลายตัวภายในบัสเดียวกันได เพียงแตมีขอแมวา อุปกรณที่จะนํามาตอรวมกันภายในบัสเดียวกันนั้น 
จะตองมีรหัสตําแหนงในการติดตอส่ือสาร (Control Byte) ที่ไมซ้ํากัน ซึ่งอุปกรณบางตัวนั้น ผูผลิตไดมีการออก
แบบใหสามารถกําหนดคารหัสตําแหนง Control Byte ไดมากกวา 1 คาเพื่อใหสามารถเชื่อมตออุปกรณประเภท
เดียวกันรวมกันภายในบัสเดียวกันไดมากกวา 1 ตัว โดยใชวิธีการกําหนดคาโลจิกใหกับขาสัญญาณสําหรับใช
ระบุตําแหนง (Address) ของอุปกรณเบอรนั้นๆไดเอง เชน I/O Port เบอร PCF8574 นั้น สามารถตอรวมกันภาย
ในบัสเดียวกันไดมากถึง 8 ตัว และยังสามารถเชื่อมตออุปกรณ I/O Port ที่มีคุณสมบัติเหมือนกันแตมีรหัส
ตําแหนงที่แตกตางกันคือ PCF8574A เพิ่มเติมไดอีก 8 ตัว ซึ่งจะเห็นไดวาอุปกรณ I/O Port นั้นสามารถทําการ
เพิ่มเติมเขาไปใหระบบบัสเดียวกันไดมากถึง 16 ตัว และในทํานองเดียวกัน หนวยความจํา EEPROM เบอร 
24LC256 ก็สามารถตอรวมกันภายในบัสเดียวกันไดมากถึง 8 ตัว จากตัวอยางขางตนจะเห็นไดวาภายในบัส
เดียวกันของ I2C นั้น อุปกรณเพียง 2 ประเภท คือ I/O และ EEPROM สามารถตอรวมกันภายในบัสเดียวกันได
มากถึง 24 ตัว คือ I/O PCF8574 8 ตัว ,PCF8574A 8ตัว และ 24LC256 อีก 8 ตัว และยังสามารถนําอุปกรณ 
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I2C อื่นๆที่มีรหัสตําแหนงของ Control Byte ไมซ้ํากันมาตอเพิ่มเติมไดอีก แตอยางไรก็ตามถึงแมวาอุปกรณแบบ 
I2C นี้ยอมใหมีการเชื่อมตอรวมกันภายในบัสเดียวกันไดหลายตัวภายในระบบบัสเดียวกันก็ตาม แตในทางปฏิบัติ
แลวอาจเกิดขอจํากัดในเรื่องของโหลด (FAN-IN/FAN-OUT) เนื่องจากคุณสมบัติของ Port I/O ของ CPU เอง ก็มี
ขอจํากับในการขับกระแสใหกับโหลดไดประมาณ 20mA เทานั้น ซึ่งคงไมสามารถตออุปกรณรวมกันในบัสไดโดย
ไมจํากัดจํานวนเหมือนในทฤษฎีบอกไว ซึ่งในความเปนจริงอาจตองพิจารณาตามความเหมาะสมและความจํา
เปนในการใชงานจริงๆดวยวาในระบบบัสหนึ่งๆของ I2C นั้นควรตออุปกรณในบัสจํานวนเทาใด 

 

 หนาที่และเบอร รหัสตําแหนงมาตรฐาน รหัสตําแหนงของบอรด CP-AVR V4.0  
 ของอุปกรณ I2C ในการอาน/เขียน รหัสตําแหนงในการอาน รหัสตําแหนงในการเขียน  
 RTC : PCF8583 [1][0][1][0][0][0][X][?] [1][0][1][0][0][0][1][1] [1][0][1][0][0][0][1][0]  
 E2PROM:24XX [1][0][1][0][X][X][X][?] [1][0][1][0][1][0][0][1] [1][0][1][0][1][0][0][0]  
 I/O : PCF8574 [0][1][0][0][X][X][X][?] [0][1][0][0][0][0][0][1] [0][1][0][0][0][0][0][0]  
 I/O : PCF8574A [0][1][1][1][X][X][X][?] [0][1][1][1][0][0][0][1] [0][1][1][1][0][0][0][0]  

 

ตารางแสดง รหัสตําแหนงของอุปกรณ I2C ภายในบอรด CP-AVR V4.0 
 

***หมายเหตุ*** 1.  คา X หมายถึงคาโลจิกของขาสัญญาณ Address ของอุปกรณ ที่กําหนดในวงจร 
  2. คา ? หมายถึงบิตสําหรับกําหนดวาตองการเขียน หรือ อาน ขอมูลกับอุปกรณ 
  3. เนื่องจาก RTC เบอร PCF8583 และ EEPROM เบอรในกลุม 24XX นั้นมีรหัสตําแหนง 4
บิตแรก ซ้ํากัน หรือ อยูในกลุมเดียวกัน ซี่งในบอรด CP-AVR V4.0 นั้นออกแบบให RTC เบอร PCF8583 มีรหัส
ตําแหนงของ Control Byte คงที่เปน 1010001X ไว สวน EEPROM ก็กําหนดรหัสตําแหนง Control Byte ไวที่ 
1010100X ดังนั้นถาตองการเพิ่มเติมอุปกรณใดๆเขาไปอีกตองกําหนดใหคา Control Byte ของอุปกรณที่จะตอ
เพิ่มเขาไปไมซ้ํากับคา Control Byte ทั้งสองดังกลาวนี้ดวย 
 
การใชงาน I2C RTC เบอร PCF8583 

สําหรับวงจรฐานเวลา RTC นั้น ในบอรด CP-AVR V4.0 นั้น จะเลือกใช Chips Support ของ PHILIPS 
เบอร PCF8583 ซึ่งเปนชิพฐานเวลาแบบ I2C-Bus และมีฐานเวลาใหใชงานอยางครบถวน ตั้งแต วินาที/นาที/ชั่ว
โมง/วันที่/เดือน/วันในสัปดาห และปคศ. นอกจากนี้ยังมีความออนตัวในการใชงานคอนขางดีเกี่ยวกับระบบเวลา 
เชน คาของชั่วโมงสามารถกําหนดไดจากโปรแกรมวาจะใหเปนระบบ 12 ชั่วโมง หรือ 24 ชั่วโมง และในสวนของ
วันที่และวันในสัปดาหก็สามารถปรับเปล่ียนไดเองวา เดือนใดมี 28/29/30 หรือ 31 วันอยางอัตโนมัติ ซึ่งนอกจาก
จะใชงานเปนฐานเวลา RTC แลว PCF8583 นี้ยังมีฟงกชั่นพิเศษในการตั้งเวลาสําหรับเปดปดการทํางานของ
อุปกรณตางๆ (ALARM FUNCTION) ไดอีกดวย นอกจากนี้แลวในตัวของ RTC เองยังมีหนวยความจํา RAM 
ขนาด 8บิต จํานวน 240ไบท สําหรับใหผูใชนําไปใชงานเก็บขอมูลไดอยางอิสระ เชน อาจนําไปใชในการเก็บคา
การตั้ง เวลา เพื่อใช ตั้งเวลาเปด-ปด อุปกรณไฟฟา เปนตน 
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       รูปแสดง โครงสรางภายในของ RTC เบอร PCF8583 
 

 จะเห็นไดวา PCF8583 ประกอบขึ้นจากวงจรหลายๆสวน เชน วงจร Power-on Reset วงจรเชื่อมตอ
แบบ I2C วงจรถอดรหัสตําแหนงแอดเดรส วงจรหารความถี่ และวงจรกําเนิดความถี่ขนาด 32.768KHz โดยตอง
ตอคริสตัลจากภายนอกใหกับขา OSCI และ OSCO ดวย สําหรับหนวยความจํานั้น PCF8583 จะมีโครงสราง
ของหนวยความจําขนาด 8บิต จํานวน 256 ไบท โดยจัดสรรสําหรับแบงออกเปนรีจิสเตอรของสวนที่เปนฐานเวลา
จํานวน 16ไบท(00H-0FH) และใชงานเปน หนวยความจํา RAM ทั่วไปไดอีก 240ไบท(10H-FFH) ซึ่งในการ
ประยุกตใชงานนั้น ตามปรกติแลวจะสามารถใชงานในหนาที่ของ RTC(Clock Mode) หรือใชงานเปนตัวนับ 
Counter (Event Counter) สําหรับนับความถี่จากขาสัญญาณ OSCI ก็ได แตสําหรับวงจรของ PCF8583 ภาย
ในบอรด CP-AVR V4.0 นั้นจะออกแบบใหใชงาน PCF8583 ในโหมด RTC หรือ Clock Mode เทานั้น 
 
การติดตอส่ือสารกับ RTC เบอร PCF8583 
 ในการเขียนโปรแกรมติดตอกับ RTC นั้น จะใชวิธีการเชื่อมตอแบบมาตรฐาน I2C Bus โดยใน RTC 
เบอร PCF8583 นี้จะมีตําแหนงแอดเดรสในการติดตอภายในบัส หรือ Control Byte เปน “1010001X” ดังนั้นใน
การติดตอกับ RTC ไมวาจะเปนการเขียนขอมูลหรืออานขอมูลจากตัว RTC ก็ตาม หลังจากสรางสภาวะเริ่มตน 
(Start Condition) แลวจะตองสงคา Control Byte ของตัว RTC ในบัส ดวยคา “1010001X”  เพื่อบอกให RTC 
รับรูวา CPU ตองการจะอานหรือเขียนขอมูลใหกับ RTC จากนั้นจึงสงรหัส ไบทแอดเดรส เพื่อระบุตําแหนงแอด
เดรสเริ่มตนภายในตัว RTC ที่ตองการจะอานหรือเขียนขอมูลใหกับ RTC เปนลําดับตอไป โดยถาเปนตําแหนง
แอดเดรสของฐานเวลาภายในตัว RTC จะมีคาตําแหนงแอดเดรสอยูระหวาง 00H-0FH แต ถาเปนตําแหนงแอด
เดรสของ RAM ภายในตัว RTC จะมีคาอยูระหวาง 10H-FFH ตามลําดับ โดยรหัส Control Byte ของ RTC นั้นมี
ลักษณะโครงสรางดังนี้ 
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รูปแสดง โครงสรางของ Control Byte ของ PCF8583 
 
 ซึ่งจะเห็นวาตามสภาวะปรกติแลว Control Byte ของ PCF8583 นั้น สามารถเลือกได 2 คา โดยการ
กําหนดโลจิกใหกับขาสัญญาณ A0 ของ PCF8583 เอง ดังนั้นในระบบบัสเดียวกัน จึงสามารถทําการติดตั้ง RTC 
เบอร PCF8583 นี้ได 2 ตัว โดยตองกําหนดใหขาสัญญาณ A0 ของแตละตัวมีสภาวะเปน “0” และ “1” ซึ่ง ตัวที่
ขาสัญญาณ A0 มีสภาวะเปน “0” ก็จะมีรหัส Control Byte เปน “1010000X” สวนตัวที่ขาสัญญาณ A0 ไดรับ
สภาวะลอจิกเปน “1” ก็จะมีรหัส Control Byte เปน “1010001X” แทน 
 แตสําหรับบอรด CP-AVR V4.0 นั้น จะกําหนดใหขาสัญญาณ A0 ของ PCF8583 มีสภาวะทางโลจิก
เปน “1” คงที่ไวเลย ดังนั้น RTC เบอร PCF8583 ในบอรด CP-AVR V4.0 นั้นจึงมีรหัส Control Byte คงที่เปน 
“1010001X” เสมอ 
 
 ***หมายเหตุ*** คา X หรือ บิต0(R/W) ใน Control Byte เปนบิตสําหรับกําหนดคุณสมบัติในการอาน
หรือเขียนขอมูลกับอุปกรณ I2C โดยถาหากวาบิต0 มีคาเปน “0” จะหมายถึง CPU ตองการเขียนคาไปยังอุปกรณ 
แตถาคาในบิต0 มีคาเปน “1” จะหมายถึง CPU ตองการอานคาจากอุปกรณ เชนรหัส Control Byte ของ RTC 
เบอร  PCF8583 มี ค า  “1010001X” ถ าต อ งการเขี ยนค า ไปยั ง  RTC จะต อ งส งรหั ส  Control Byte เป น 
“10100010” แตถาตองการอานคาจาก RTC ก็จะตองสงรหัส Control Byte ดวยคา “10100011” แทน เปนตน 
 
การใชงานหนวยความจํา EEPROM (24XX) 
 หนวยความจํา Serial EEPROM ที่ใชในบอรดจะใชการเชื่อมตอแบบ I2C-Bus ในตระกูล 24XX ซึ่ง
หนวยความจําแบบนี้มีคุณสมบัติที่นาสนใจหลายประการคือ มีตัวถังขนาดเล็ก ใชสัญญาณในการเชื่อมตอนอย
เสน และสามารถเก็บรักษาขอมูลไวไดนานกวา 200 ป นอกจากนี้ยังสามารถลบและเขียนซ้ําไดถึง 1 ลานครั้ง 
(อางอิงจาก Microchip) จึงสามารถนําไปประยุกตใชงาน ในดานที่เกี่ยวของกับการเก็บรักษาขอมูลสําหรับงาน
ตางๆไดดี 
 โดยผูใชเองสามารถเลือกติดตั้งหนวยความจําเพื่อใชงาน กับบอรดไดมากมายหลายเบอร ขึ้นอยูกับจุด
ประสงคและขนาดของหนวยความจําที่ตองการ โดยใหเลือกใช EEPROMในตระกูล 24XX (I2C Bus) ในกลุมที่
สามารถกําหนดรหัส Control Byte ของหนวยความจําจากฮารดแวร (ขาสัญญาณ A2,A1 และ A0) ได เชน 
เบอร 24XX32,64,128 และ 24XX256 ของ Microchip เปนตน 

สําหรับหนวยความจําเบอร 24XX32,24XX64,24XX128 และ 24XX256 ของ Microchip นั้น จะเห็นได
วารหัส Control Byte ในตําแหนง 4บิตบน (บิต7,6,5 และ 4) จะมีคาเปน “1010” สวน บิต3 บิต2 และ บิต1 นั้น
จะขึ้นอยูกับสภาวะทางลอจิกของขาสัญญาณ A2,A1 และ A0 ในวงจร ซึ่งจากคุณสมบัติดังกลาวจะทําให

1 0 1 0 0 0 A0 R/W
บิต7 บิต6 บิต5 บิต4 บิต3 บิต2 บิต1 บิต0
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สามารถทําการตอหนวยความจําดังกลาวไดมากถึง 8 ตัวภายในระบบบัสเดียวกัน โดยกําหนดสภาวะของขา 
สัญญาณลอจิกแอดเดรสที่แตกตางกันออกไป โดยสามารถสรุปใหเห็นไดดังตารางตอไปนี้ 

 

เบอร(ความจุ) Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 
24XX32 (4Kx8) 1 0 1 0 A2 A1 A0 R/W 
24XX64 (8Kx8) 1 0 1 0 A2 A1 A0 R/W 
24XX128 (16Kx8) 1 0 1 0 A2 A1 A0 R/W 
24XX256 (32Kx8) 1 0 1 0 A2 A1 A0 R/W 

 

ตารางแสดง รหัส Control Byte ของหนวยความจําแบบ I2C Bus ของ Microchip 
 

 จากตารางจะเห็นไดวา หนวยความจํา EEPROM แบบ  I2C-BUS นั้น  24XX32/64/128/256 ของ 
Microchip นั้นจะมีรหัส Control Code ที่เหมือนกันทุกเบอร แตจะมีความแตกตางกันที่ขนาดของหนวยความจํา 
ดังนั้นเมื่อทําการติดตั้งใชงานหนวยความจําเบอรเหลานี้กับบอรด CP-AVR V4.0 แลวจะมีรหัส Control Byte 
เปน “1010100X” คงที่ตลอด แตถามีการตอหนวยความจําเหลานี้เพิ่มเติมจากภายนอกบอรดแลวรหัส Control 
Byte ก็จะขึ้นอยูกับการกําหนดสภาวะทางลอจิกใหกับขาสัญญาณ A2,A1 และ A0 ของหนวยความจําที่ตอไว 
  
การใชงาน I/O Port แบบ I2C (PCF8574/A) 

หากในการใชงานมีความจําเปนตองใชงานพอรต I/O จํานวนมาก และจํานวนพอรต I/O ของ CPU ที่มี
อยูไมเพียงพอตอการใชงานแลว ผูใชสามารถทําการเพิ่มเติมพอรต I/O ไดอีก โดยในบอรด CP-AVR V4.0 นั้นจะ
ออกแบบใหผูใชสามารถทําการเพิ่มเติม พอรต I/O แบบ I2C ซึ่งมีขนาด I/O จํานวน 8 บิต I/O โดยใชไอซี สําหรับ
ทําหนาที่เปนพอรต I/O ของ Phillips เบอร PCF8574 หรือ PCF8574A โดย PCF8574/A มีโครงสรางดังรูป 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปแสดง Block Diagram ของ PCF8574/A 
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โดยที่ พอรต I/O เบอร PCF8574/A นั้น ตามปรกติแลวจะสามารถใชงานเปน Input หรือ Output ก็ได
ตามตองการ แตจําเปนตองเลือกกําหนดหนาที่เพียงหนาที่เดียวเทานั้น ไมสามารถใชงานเปนทั้ง Input และ 
Output ในเวลาเดียวกันได โดยลักษณะโครงสรางภายในของขาสัญญาณ I/O ของ PCF8574 เปนดังนี้ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
รูปแสดง ลักษณะโครงสรางของขาสัญญาณ I/O แตละขาของ PCF8574/A 
 
นอกจากนี้แลวผูใชงานยังสามารถทําการขยาย จํานวนพอรต I/O ของ PCF8574/A นี้ไดอีกมากถึง 15 

ตัว (120 บิต I/O) ทางขั้วตอ “I2C EXPAND” ของบอรด เนื่องจาก PCF8574 หรือ PCF8574A นั้น สามารถตอ
รวมกันภายในระบบบัสเดียวกันไดมากถึงอยางละ 8 ตัว กลาวคือ ในระบบบัสของ I2C นั้น จะสามารถตอใชงาน 
PCF8574 ไดมากถึง 8 ตัว และยังสามารถตอพอรต I/O เบอร PCF8574A ไดอีก 8 ตัว รวมเปน 16 ตัวภายในบัส
เดียวกัน โดยการกําหนดตําแหนงแอดเดรสของอุปกรณแตละตัวใหมีความแตกตางกัน ซึ่งตามปรกติแลว 
PCF8574 หรือ PCF8574A นั้น จะมีขาสัญญาณแอดเดรสจํานวน 3 เสน คือ  A0,A1 และ A2 โดยการกําหนด
สภาวะทางโลจิกใหกับขาสัญญาณแอดเดรสทั้ง 3 ใหมีคาไมซ้ํากัน โดย PCF8574 และ PCF8574A นั้น จะมีคุณ
สมบัติและวิธีการใชงานที่เหมือนกันทุกประการ แตกตางกันเพียงรหัส Control Byte เทานั้น โดยโครงสรางของ
รหัส Control Byte ของ PCF8574 และ PCF8574A สามารถแสดงใหเห็นไดดังนี้ 
 
 
 
 

รูปแสดง รหัส Control Byte ของ PCF8574 
 
 

0 1 0 0 A2 A1 A0 R/W
บิต7 บิต6 บิต5 บิต4 บิต3 บิต2 บิต1 บิต0
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รูปแสดง รหัส Control Byte ของ PCF8574A 

 
 สําหรับรหัส  Control Byte ของพอรต  I/O เบอร PCF8574 หรือ  PCF8574A ของบอรดนั้น  จะถูก
กําหนดไวตายตัว โดยขาสัญญาณแอดเดรส A0,A1 และ A2 จะถูกกําหนดสภาวะโลจิกเปน “0” ไวทั้งหมด ซึ่งใน
กรณีที่ผูใชทําการติดตั้งพอรต I/O เบอร PCF8574 จะมีรหัส Control Byte เปน “0100000X” แตสําหรับกรณีที่ผู
ใชทําการติดตั้งพอรต I/O เบอร PCF8574A จะมีรหัส Control Byte เปน “0111000X” แทน 

 
การใชงานพอรตสื่อสารอนุกรม SPI/RS232/RS422/RS485 
 พอรตที่ใชในการสื่อสารขอมูลแบบอนุกรมใน CPU เบอร 90S8535 จะมีอยู 2 พอรตดวยกันนั่นคือ SPI 
Port กับ Serial Port (RS232) สวน ATmega163 นั้น จะมีพอรตที่ใชในการสื่อสารขอมูลอนุกรมอยู 3 พอรตดวย
กันไดแกพอรต SPI  พอรตอนุกรม(RS232) และพอรต 2-wire Serial Interface ซึ่งพอรตนี้จะตอออกมาใชงาน
ภายนอกผานทางขั้ว I2C EXPAND และ ขั้วตอ I/O 34 Pin สําหรับบอรด CP-AVR V4.0 เราไดตอวงจร RS422 
และ RS485 เพิ่มเติม โดยใชไอซีเบอร 75176 ชวยปรับระดับของสัญญาณ ตอไปนี้เราจะกลาวถึงพอรตส่ือสาร
อนุกรมแบบตางๆ ที่อยูบนบอรดทั้ง 3 รุน 
 
การสื่อสารอนุกรม SPI 
 สําหรับพอรต SPI (Serial Peripheral Interface Port) นั้นปรกติเราจะใชในการดาวนโหลดโปรแกรม 
แตเราสามารถนํามันมาใชในการรับสงขอมูลแบบอนุกรมไดเชนเดียวกันกับพอรตอนุกรมอื่นๆ โดยในการใชงาน
นั้นเราจะตองมี CPU ที่ทําหนาที่เปนตัวมาสเตอรและ CPU ที่ทําหนาที่เปนตัวสเลฟ นั่นแสดงวาเราจะตองมี 
CPU อยางนอย 2 ตัวขึ้นไป และเราสามารถกําหนดให CPU ตัวที่จะมาตอกับพอรตนี้เปนตัวมาสเตอรหรือสเลฟ
ก็ไดโดยการ Short Jumper VCC/PB4/GND ดังรูปตอไปนี้ 
 
 
 
 
 

                     (ก)                 (ข)                 (ค) 
(ก) ทํางานในโหมด Master         
(ข) กําหนดโหมดการทํางานไดจากโปรแกรม        
(ค) ทํางานในโหมด Slave 

รูปแสดง การกําหนด jumper  ใหกับพอรต SPI เพื่อเลือกโหมดการทํางาน 

0 1 1 1 A2 A1 A0 R/W
บิต7 บิต6 บิต5 บิต4 บิต3 บิต2 บิต1 บิต0
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จากรูปขางบนอธิบายไดวา หากเราตองการให CPU ที่มาตอกับขั้วนี้ทํางานในโหมด Master ก็ใหทํา
การเลือก Jumper ดังรูป (ก)  และถาเราเลือก Jumper ดังรูป (ข) จะทําใหเราสามารถเขียนโปรแกรมควบคุม 
CPU ไดวาเราตองการใหมันทํางานอยูในโหมดSlave หรือ Master แตถาเราเสียบ jumper ดังรูป (ค) จะเปนการ
กําหนดให CPU ทํางานในโหมด Slave   

รูปตอไปนี้จะเปนการอธิบายถึงการตอ CPU 2 ตัวเขาดวยกันโดยการสื่อสารขอมูลจะทําผานพอรต SPI 
ซึ่งจากรูปทานจะพบวาขา MOSI (Master Out Slave In) ของตัวมาสเตอรตออยูกับขา MOSI ของอุปกรณ 
สเลฟ  และขา MISO (Master In Slave Out) ของตัวมาสเตอรจะตออยูกับ MISO ของตัว Slave สวนขา SCK 
ของ CPU ทั้งสองตัว จะตอเขากับ clock ตัวเดียวกันเพื่อใหเกิดการซิงโครนัสในการสงขอมูล ขา ss  ของตัวมาส
เตอรจะตออยูกับ VCC สวนขา ss ของตัวสเลฟจะตออยูกับ GND  8 Bit Shift Register เปนรีจิสเตอรที่อยูใน 
CPU ทําหนาที่ในการเก็บขอมูลและเลื่อนขอมูลเขาออก ดังนั้นเมื่อเราตอ CPU ดังรูป การทํางานของมันจะเปน
เหมือนการนํารีจิสเตอร 8 บิต 2 ตัวมาตอกันเปนรีจิสเตอรขนาด 16 บิต 1 ตัว นั่นเอง  

 
 
 
 
 
 

 
  
          รูปแสดง การตอ CPU 2 ตัวเขาดวยกันผาน SPI Port 
 
การสื่อสารอนุกรมแบบ RS232  

ในกรณีนี้จะตองทําการติดตั้งไอซี Line Driver เพื่อเปล่ียนระดับสัญญาณทางไฟฟาของขาสัญญาณ
สําหรับ รับ-สง ขอมูลแบบ TTL ของ CPU (RX และ TX) ใหเปนระดับสัญญาณทางไฟฟาแบบ RS232 (±12V)  
โดยการติดตั้งไอซีเบอร MAX232 เพื่อทําหนาที่เปล่ียนระดับสัญญาณ TTL จากขาสัญญาณสงขอมูล (TX) ของ 
CPU ใหเปนระดับสัญญาณ ±12V สําหรับสงไปยังขารับสัญญาณ (RX) ของอุปกรณภายนอก และในทางกลับ
กัน ก็จะทําหนาที่เปล่ียนระดับสัญญาณสง (TX) แบบ RS232 (±12V) จากอุปกรณภายนอก ใหกลับมาเปน
ระดับ TTL เพื่อสงใหกับขารับขอมูล (RX) ของ CPU ดวย โดยเมื่อเปล่ียนระดับสัญญาณในการรับสงขอมูลจาก 
TTL มาเปนแบบ RS232 นี้แลวจะทําใหสามารถทําการ รับ-สง ขอมูลกับอุปกรณภายนอกที่ใชระดับสัญญาณ
ทางไฟฟาในการ รับ-สง แบบเดียวกัน (RS232) ไดไกลขึ้น ประมาณ 50ฟุต หรือ ประมาณ 15 เมตร โดยสามารถ
ทําการ รับ-สง ขอมูลกับอุปกรณตางๆไดในลักษณะของตัวตอตัว (Point-to-Point) เทานั้น 

สําหรับสายสัญญาณที่จะนํามาใชสําหรับทําการสื่อสารแบบ RS232 นั้น จะใชสัญญาณเพียง 2-3 เสน 
เทานั้น ทั้งนี้ขึ้นอยูกับความตองการในการสื่อสารวาตองการสื่อสารแบบทิศทางเดียวหรือสองทิศทาง 

- การส่ือสาร RS232 แบบสองทิศทาง ซึ่งจะมีทั้งการรับขอมูลและสงขอมูลไปมา ระหวางดานรับ
และดานสง โดยในกรณีนี้จะตองใชสายสัญญาณจํานวน 3 เสน สัญญาณรับขอมูล (RXD) 
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สัญญาณสงขอมูล(TXD) และสัญญาณอางอิง (GND) โดยในการเชื่อมตอสายนั้นจะตองทําการ
สลับสัญญาณกับอุปกรณปลายทางดวย คือ สัญญาณสง (TXD) จากบอรด CP-AVR จะตองตอ
เขากับสัญญาณรับ  (RXD) ของอุปกรณ  และสัญญาณสง (TXD) จากอุปกรณก็ตองตอกับ
สัญญาณรับ (RXD) ของบอรด สวนสัญญาณอางอิง (GND) จะตองตอตรงถึงกัน จึงจะสามารถ
ทําการ รับ-สง ขอมูลกันได 

- การส่ือสาร RS232 แบบทิศทางเดียว ซึ่งอาจเปนการรอรับขอมูลจากดานสงเพียงอยางเดียว 
หรืออาจเปนการสงขอมูลออกไปยังปลายทางเพียงอยางเดียว โดยไมมีการโตตอบขอมูลซึ่งกันและ
กัน ซึ่งวิธีนี้จะใชสายสัญญาณเพียง 2 เสน เทานั้น โดยถาเปนทางดานสง ก็จะตอเพียงสัญญาณ
สง (TXD) และสัญญาณอางอิง (GND) แตถาเปนทางดานรับ ก็จะตอเพียงสัญญาณรับ (RXD) 
และ สัญญาณอางอิง (GND) เทานั้น  

 
โดยขั้วตอของสัญญาณ RS232 ของบอรด CP-AVR ทั้ง 3 รุน นั้น จะเปนจุดเชื่อมตอของสัญญาณ รับ-

สง ขอมูล ที่เปล่ียนระดับสัญญาณเปนแบบ RS232 แลว ซึ่งจะมีลักษณะเปนแบบขั้ว CPA ขนาด 4 PIN สําหรับ
ใชเปนจุดเชื่อมตอสัญญาณ รับ-สง ขอมูลกับอุปกรณภายนอก โดยมีลักษณะการจัดเรียงสัญญาณดังนี้ 

 
 
 
 
 

รูปแสดง ขั้วตอสัญญาณ RS232 ของบอรด CP-AVR V3.0/V3.0 EXP/V4.0 
 

 ซึ่งจะเห็นไดวาขั้วตอสัญญาณ RS232 ของบอรดนั้น จะมีทั้งหมด 4 เสน แตในการ รับ-สง ขอมูลแบบ
ปรกตินั้น จะใชสัญญาณเพียงแค 3 เสน คือ RXD,TXD และ GND เทานั้น สวน +VCC ซึ่งเปนไฟเลี้ยงวงจร +5V 
นั้น จะไมจําเปนตองนํามาใชในการสื่อสารกันแตอยางใด โดย +VCC หรือ +5V นี้ จะออกแบบเผื่อไวในกรณีที่
อุปกรณปลายทางเปนวงจรขนาดเล็กและไมสะดวกที่จะหาแหลงจายไฟใหกับอุปกรณปลายทางดวย ก็อาจตอ
ไฟเลี้ยงวงจร +VCC นี้ออกไปใหกับอุปกรณปลายทางดวยก็ไดเชนกัน 

 
****หมายเหตุ*** สําหรับไอซี Line Drive แบบ RS232 นั้น จะจัดเปนอุปกรณมาตรฐานของบอรดใน

ตระกูล CP-AVR ซึ่งจะมีติดตั้งใหไปกับบอรดอยูแลว ผูใชไมตองจัดหาเพิ่มเติม แตพึงระลึกไวเสมอวา จะตองทํา
การติดตั้งไอซี Line Driver สําหรับเลือกชนิดสัญญาณทางไฟฟาของการสื่อสารอนุกรม ไดเพียงอยางใดอยาง
หนึ่งเทานั้น เชน เมื่อเลือกติดตั้งไอซี Line Driver เปนแบบ RS232 โดยการติดตั้ง MAX232 ในบอรดแลว จะตอง
ไมติดตั้งไอซี Line Driver แบบอื่น เชน RS422 หรือ RS485 เขาไปดวย เพราะจะทําใหไมสามารถรับสงขอมูลกัน
ไดอยางถูกตอง ผูใชตองเลือกติดตั้งไอซี Line Driver อยางใดอยางหนึ่งเทานั้น 
 
 

+VCC

RXD

TXD

GND
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การสื่อสารอนุกรมแบบ RS422  
ในกรณีนี้จะตองทําการติดตั้งไอซี Line Driver เบอร 75176 หรือ MAX3088 จํานวน 1-2 ตัว เพื่อทํา

หนาที่เปล่ียนระดับสัญญาณไฟฟาในการ รับ-สง แบบ TTL จาก CPU ใหเปนระดับสัญญาณแบบ Balance Line 
เพื่อ รับ-สงสัญญาณกับอุปกรณที่มีระดับสัญญาณทางไฟฟาเปนแบบ Balance Line เหมือนกัน โดยถาตองการ
ใชการสื่อสารแบบ 2 ทิศทาง ก็จะตองติดตั้งไอซี Line Driver จํานวน 2 ตัว โดยแบงเปนตัวแปลงสัญญาณทาง
ดานรับ 1 ตัว และตัวแปลงสัญญาณดานสงอีก 1 ตัว แตถาตองการสื่อสารแบบทิศทางเดียวก็อาจทําการติดตั้ง
ไอซี Line Driver เพียงตัวเดียว โดยถาตองการใหเปนฝายรับขอมูลเพียงอยางเดียวก็ใหติดตั้งไอซี Line Driver 
เฉพาะในตําแหนงของ “RXD/422” เพียงตัวเดียว แตถาตองการใหเปนฝายสงขอมูลเพียงอยางเดียวก็ใหทําการ
ติดตั้งไอซี Line Driver เฉพาะในตําแหนง “TXD/485” เพียงตัวเดียวเทานั้น 

ซึ่งการสื่อสารแบบ RS422 นี้ สามารถนําไปทดแทนการสื่อสารแบบ RS232 ไดทันที โดยไมตองดัด
แปลงหรือแกไขโปรแกรมเลย ซึ่งการสื่อสารโดยใชระดับสัญญาณในการ รับ-สง แบบ RS422 นี้จะมีขอดี คือ
สามารถทําการสื่อสารกันไดในระยะทางที่ไกลขึ้นกวาแบบ RS232 มาก กลาวคือ สามารถจะทําการ รับ-สง ขอ
มูลกันไดในระยะทางประมาณ 4000 ฟุต หรือ 1200 เมตร เลยทีเดียว เพียงแตตองใชสายสัญญาณที่ออกแบบ
มาสําหรับรองรับการใชงานในดานการสื่อสารแบบนี้โดยเฉพาะ ซึ่งไดแก สายสัญญาณแบบ UTP (Un-Shiled 
Twist Pair) หรือ STP (Shiled Twist Pair) โดยการสื่อสารดวยระดับสัญญาณทางไฟฟาแบบ RS422 นี้ ถาเปน
การสื่อสารแบบ 2 ทิศทาง คือ ทั้งรับขอมูลและสงขอมูล จะสามารถทําการรับสงขอมูลกับอุปกรณตางๆไดใน
ลักษณะของตัวตอตัว (Point-to-Point) เหมือนกับ RS232  ทุกประการ แตในกรณีที่เปนการสื่อสารแบบทิศทาง
เดียวนั้น สามารถจะทําการตอขนานสัญญาณทางดานรับ จํานวนหลายๆจุด เขากับสัญญาณสงเพียงจุดเดียวได 
โดยถาเลือกใชไอซี Line Driver เบอร 75176 จะสามารถตอขนานจํานวนอุปกรณสําหรับดานรับขอมูลได
ประมาณ 32จุด แตถาเลือกใชไอซี Line Driver เบอร MAX3088 นั้น จะสามารถตอขนานจํานวนอุปกรณทาง
ดานรับขอมูลไดมากถึง 256 จุด เลยทีเดียว แตถาเปนอุปกรณทางดานสงนั้น จะไมสามารถนํามาตอขนาน
สัญญาณสงขอมูลเขาดวยกันมากกวา 1 จุด เหมือนทางดานฝายรับได ซึ่งวงจร Line Driver แบบ RS422 นี้จะมี
อยูเฉพาะในบอรดรุน CP-AVR V4.0 เทานั้น  

สําหรับลักษณะของขั้วตอของสัญญาณ RS422 นั้น จะเปนแบบ CPA ขนาด 6 PIN ดังรูป โดยในการ
ส่ือสารกันนั้น จะใชสายสัญญาณในการ รับ-สง ขอมูลกัน จํานวน 4 เสนสัญญาณ คือ สัญญาณในการรับขอมูล 
จํานวน 2 เสน คือ RXA (RX+) และ RXB (RX-) และสัญญาณในการสงขอมูลอีก 2 เสน คือ TXA (TX+) และ 
TXB (TX-) ซึ่งในการตอสัญญาณนั้น จะตองทําการตอสัญญาณในลักษณะของการสลับกัน คือ สัญญาณสงจะ
ตองตอเขากับสัญญาณรับ นั่นก็คือ สัญญาณ RXA (RX+) จะตองตอกับ TXA (TX+) สวน RXB (RX-) ก็จะตอง
ตอกับ TXB (TX-) ดวยเชนกัน โดยลักษณะของขั้วตอสัญญาณ RS422 เปนดังรูป 
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การสื่อสารอนุกรมแบบ RS485  
 ในการสื่อสารแบบ RS485 นี้จะมีคุณสมบัติของสัญญาณทางไฟฟาเหมือนกับ RS422 ทุกประการ 
เพียงแตวาในการสื่อสารแบบ RS485 นี้จะใชสายสัญญาณในการรับสงขอมูลกันเพียง 2 เสน เทานั้น แตจะมี
ความพิเศษกวาแบบ RS422 ตรงที่ ทิศทางของสัญญาณจะสามารถปรับเปล่ียนไดจากโปรแกรม กลาวคือ 
สัญญาณทั้ง 2 เสน นี้สามารถจะสลับหนาที่เปนดานสง และ เปนดานรับได ตามตองการ โดยการควบคุมจาก 
CPU โดยจากบอรด CP-AVR V4.0 นั้น จะกําหนดใหสัญญาณ PD7 ทําหนาที่สําหรับควบคุมทิศทางของขอมูล
วาจะใหเปนรับหรือสง โดยถาควบคุมให PD7 มีสภาวะเปน “1” จะเปนการกําหนดทิศทางใหเปนฝายสงขอมูล 
แตถาสภาวะของ PD7 เปน “0” จะเปนการกําหนดทิศทางใหเปนฝายรับขอมูล ซึ่งจากคุณสมบัติขอนี้จะทําให
การสื่อสารแบบ RS485 สามารถทําการตอขนานอุปกรณรวมกันในสายสงเดียวกันไดจํานวนหลายๆจุด โดยถา
ใชไอซี Line Driver เบอร 75176 จะสามารถตอขนานอุปกรณกันได จํานวน 32 จุด แตถาเลือกใชไอซี Line 
Driver เบอร MAX3088 แลวจะสามารถตอขนานอุปกรณในสายคูเดียวกันไดมากถึง 256 จุด เลยทีเดียว แตมีขอ
แมวา เมื่อมีการตออุปกรณขนานกันในสายสัญญาณคูเดียวกันมากกวา 2 จุดแลว จะตองเขียนโปรแกรมควบคุม
ใหมีการสงขอมูลออกมาในสายครั้งละ 1  จุดเทานั้น เพราะถามีการกําหนดทิศทางของขอมูลใหเปนสงในเวลา
เดียวกันมากกวา 1 จุดแลวจะทําใหเกิดการชนกันของขอมูลและไมสามารถสื่อสารกันไดอยางถูกตอง 
 โดยเมื่อตองการใชวิธีการสื่อสารแบบ RS485 นี้ จะตองทําการติดตั้งไอซี Line Driver เบอร 75176 
หรือ MAX3088 ในตําแหนงของ “TXD/485” เพียงตัวเดียว พรอมกับเลือกกําหนดเปนแบบ RS485 ดังนี้ 

- ทําการเลือก Jumper สําหรับเลือก “422/485” ไวทางดาน 485 (RS485) 
- ทําการเลือก Jumper “F/H” ไวทางดาน H (Half Duplex) 
- ทําการ Short Jumper สําหรับตอตัวตานทาน Fail Safe Resister คือ “TL” ไว 
- ทําการ Short Jumper  สําหรับตอตัวตานทาน Fail Safe Resister คือ “TH” ไว 
- สายสัญญาณที่ใชจะตอจาก TXB(TX-) และ TXA(TX+) เพียง 2 เสน ออกไปใชงาน 
ซึ่งในการสื่อสารขอมูลแบบ RS485 นี้ จะตองเขียนโปรแกรมขึ้นมารองรับการสื่อสารโดยเฉพาะ เนื่อง

จากทิศทางของขอมูลสามารถจะกําหนดจากโปรแกรมไดโดยตรง ซึ่งการสื่อสารวิธีนี้จะมีขอดีคือ ใชสาย
สัญญาณในการรับสงนอยเสน แตจะเสียเวลาในการสื่อสารมากกวาวิธีอื่นๆ เนื่องจากวา การส่ือสารแบบนี้จะไม
สามารถทําการรับและสงขอมูลในเวลาเดียวกันได แตจะตองใชวิธีการ ผลัดกันรับ ผลัดกันสง แทน ซึ่งในความ
เปนจริงแลวในปจจุบันนี้ ราคาของสายสัญญาณแบบ 2 เสน และ 4 เสน แทบจะไมมีความแตกตางกันเลย ดังนั้น
เพื่อลดความยุงยากในการเขียนโปรแกรมสําหรับควบคุมการรับสงขอมูลของ CPU ขอแนะนําใหเลือกใชวิธีการ
ส่ือสารแบบ RS422 จะงายและสะดวกรวดเร็วกวากันมาก 
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การกําหนด Jumper สําหรับการสื่อสารแบบ RS422/485 
 เนื่องจากวงจร Line Driver ของพอรตส่ือสารอนุกรมของบอรดนั้น ออกแบบใหผูใชสามารถเลือก
กําหนดไดหลายแบบ ดังนั้น จึงตองมีการใช Jumper สําหรับเปนตัวเลือกรูปแบบการสื่อสารรวมดวย โดยจะมี 
Jumper ที่เกี่ยวของกับการใชงานการสื่อสารแบบ RS422 และ RS485 ดังตอไปนี้ คือ 

- Jumper 422/485 เปน Jumper สําหรับเลือกกําหนดการทํางานของไอซี Line Driver ในตําแหนง 
TXD/485 ใหทํางานเปนแบบ RS422 หรือ RS485 โดยถาตองการใหเปนแบบ RS422 จะตอง
กําหนด Jumper ไวทางดาน “422” ซึ่งจะทําใหไอซี Line Driver ตําแหนง “TXD/485” ทําหนาที่
เปนฝายสงขอมูลเพียงอยางเดียว แตถาตองการใชงานแบบ RS485 จะตองกําหนด Jumper ไว
ทางดาน “485” เพื่อกําหนดใหไอซี Line Driver ในตําแหนง “TXD/485” ทําหนาที่เปนทั้งฝายรับ
และฝายสง ตามการควบคุมของสัญญาณ PD7 

- Jumper F/H (Full/Half) เปน Jumper ใชสําหรับเลือกกําหนดรูปแบบการสื่อสารใหเปนแบบ Full 
Duplex (F) หรือ  Half Duplex (H) โดยถาตองการใชงานแบบ  RS422 จะตองเลือกกําหนด 
Jumper นี้ไวทางดาน F(Full Duplex) แตถาตองการใชงานเปนแบบ RS485 จะตองเลือกกําหนด 
Jumper นี้ไวทางดาน H(Half Duplex) แทน 

- Jumper RL เปน Jumper ใชสําหรับเลือกกําหนดการเชื่อมตอ ตัวตานทานสําหรับทําหนาที่คง
สถานะของสัญญาณ RXB (RX-) หรือ Fail Safe Resister เพื่อใหสัญญาณ RXB (RX-) มีสภาวะ
แนนอนเมื่อไมมีการสงสัญญาณใดๆออกมาในสายเลย ซึ่งถาหากวามีการตอสายสัญญาณระยะ
ทางไกลๆหรือมีการตอสายระยะทางไกลๆแตไมไดมีการสงขอมูลออกมาในสายตลอดเวลาแลว 
ควรที่จะทําการ Short Jumper นี้ไวดวยเสมอ โดยเฉพาะอยางยิ่งตัวอุปกรณที่อยูในตําแหนงตน
สายและปลายสายควรทําการ Short Jumper นี้ไวเสมอ สวนอุปกรณที่อยูในตําแหนงอื่นๆที่มี
ระยะไมไกลจากจุดตนสายและปลายสายมากนักก็อาจ Open Jumper นี้ออกก็ได แตอยางนอยที่
สุด ควรมีการ Short Jumper นี้ใหกับอุปกรณที่ตอรวมอยูในสายสัญญาณจํานวน 1 จุดเสมอ 

- Jumper RH เปน Jumper ใชสําหรับเลือกกําหนดการเชื่อมตอ ตัวตานทานสําหรับทําหนาที่คง
สถานะของสัญญาณ  RXA (RX+) หรือ  Fail Safe Resister เพื่ อให สัญญาณ  RXA (RX+) มี
สภาวะแนนอนเม่ือไมมีการสงสัญญาณใดๆออกมาในสายเลย  ซึ่งถาหากวามีการตอสาย
สัญญาณระยะทางไกลๆหรือมีการตอสายระยะทางไกลๆแตไมไดมีการสงขอมูลออกมาในสาย
ตลอดเวลาแลว ควรที่จะทําการ Short Jumper นี้ไวดวยเสมอ โดยเฉพาะอยางยิ่งตัวอุปกรณที่อยู
ในตําแหนงตนสายและปลายสายควรทําการ Short Jumper นี้ไวเสมอ สวนอุปกรณที่อยูใน
ตําแหนงอื่นๆที่มีระยะไมไกลจากจุดตนสายและปลายสายมากนักก็อาจ Open Jumper นี้ออกก็
ได แตอยางนอยที่สุด ควรมีการ Short Jumper นี้ใหกับอุปกรณที่ตอรวมอยูในสายสัญญาณ
จํานวน 1 จุดเสมอ 

- Jumper RZ เปน Jumper สําหรับเลือกกําหนดการตอตัวตานทาน RZ เพื่อชดเชย คาความตาน
ทานของสายสัญญาณ (Impedance) ทางดานรับ ซึ่งถาหากวามีการตอสายสัญญาณในการรับ
สงเปนระยะทางไกลๆแลวก็ควรทําการ Short Jumper นี้ไวดวยเนื่องจากเมื่อสายมีความยาว
มากๆจะเกิดคาความตานทานในสายขึ้น ดังนั้นจึงตองทําการตอคาความตานทานจากภายนอก
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ไปชดเชยคาความตานทานของสายสัญญาณดวย โดยเมื่อทําการ Short Jumper ตําแหนง RZ นี้
ไวก็จะเปนการตอตัวตานทานครอมระหวาง RXA (RX+) และ RXB (RX-) ไว แตถาหากวาตอสาย
สัญญาณในระยะทางที่ไมไกลมากนัก ก็ใหทําการ Open Jumper นี้ออกก็ได 

- Jumper TL เปน Jumper ใชสําหรับเลือกกําหนดการเชื่อมตอ ตัวตานทานสําหรับทําหนาที่คง
สถานะของสัญญาณ TXB (TX-) หรือ Fail Safe Resister เพื่อใหสัญญาณ TXB (TX-) มีสภาวะ
แนนอนเมื่อไมมีการสงสัญญาณใดๆออกมาในสายเลย ซึ่งถาหากวามีการตอสายสัญญาณระยะ
ทางไกลๆหรือมีการตอสายระยะทางไกลๆแตไมไดมีการสงขอมูลออกมาในสายตลอดเวลาแลว 
ควรที่จะทําการ Short Jumper นี้ไวดวยเสมอ โดยเฉพาะอยางยิ่งเมื่อใชงานเปนแบบ RS485 หรือ
ใชงานเปนตัวอุปกรณที่อยูในตําแหนงตนสายและปลายสายควรทําการ Short Jumper นี้ไวเสมอ 
สวนอุปกรณที่อยูในตําแหนงอื่นๆที่มีระยะไมไกลจากจุดตนสายและปลายสายมากนักก็อาจ 
Open Jumper นี้ออกก็ได แตอยางนอยที่สุด ควรมีการ Short Jumper นี้ใหกับอุปกรณที่ตอรวม
อยูในสายสัญญาณจํานวน 1 จุดเสมอ 

- Jumper TH เปน Jumper ใชสําหรับเลือกกําหนดการเชื่อมตอ ตัวตานทานสําหรับทําหนาที่คง
สถานะของสัญญาณ TXA (TX+) หรือ Fail Safe Resister เพื่อใหสัญญาณ TXA (TX+) มีสภาวะ
แนนอนเมื่อไมมีการสงสัญญาณใดๆออกมาในสายเลย ซึ่งถาหากวามีการตอสายสัญญาณระยะ
ทางไกลๆหรือมีการตอสายระยะทางไกลๆแตไมไดมีการสงขอมูลออกมาในสายตลอดเวลาแลว 
ควรที่จะทําการ Short Jumper นี้ไวดวยเสมอ โดยเฉพาะอยางยิ่งเมื่อใชงานเปนแบบ RS485 หรือ
ใชงานเปนตัวอุปกรณที่อยูในตําแหนงตนสายและปลายสายควรทําการ Short Jumper นี้ไวเสมอ 
สวนอุปกรณที่อยูในตําแหนงอื่นๆที่มีระยะไมไกลจากจุดตนสายและปลายสายมากนักก็อาจ 
Open Jumper นี้ออกก็ได แตอยางนอยที่สุด ควรมีการ Short Jumper นี้ใหกับอุปกรณที่ตอรวม
อยูในสายสัญญาณจํานวน 1 จุดเสมอ 

- Jumper TZ เปน Jumper สําหรับเลือกกําหนดการตอตัวตานทาน TZ เพื่อชดเชย คาความตาน
ทานของสายสัญญาณ (Impedance) ทางดานสง ซึ่งถาหากวามีการตอสายสัญญาณในการรับ
สงเปนระยะทางไกลๆแลวก็ควรทําการ Short Jumper นี้ไวดวยเนื่องจากเมื่อสายมีความยาว
มากๆจะเกิดคาความตานทานในสายขึ้น ดังนั้นจึงตองทําการตอคาความตานทานจากภายนอก
ไปชดเชยคาความตานทานของสายสัญญาณดวย โดยเมื่อทําการ Short Jumper ตําแหนง TZ นี้
ไวก็จะเปนการตอตัวตานทานครอมระหวาง TXA (TX+) และ TXB (TX-) ไว แตถาหากวาตอสาย
สัญญาณในระยะทางที่ไมไกลมากนัก ก็ใหทําการ Open Jumper นี้ออกก็ได 

 
***ขอสังเกตุ*** จะเห็นไดวาวงจร Line Driver ทั้งแบบ RS422 และ RS485 นั้นจะมีความใกลเคียง 

กันมาก แตมีขอแตกตางอยางหนึ่งที่เห็นไดชัดเจนที่สุด คือ ถาเปนแบบ RS422 จะไมสามารถสั่งเปล่ียน ทิศทาง
การรับสงขอมูลดวยโปรแกรมได ซึ่งทิศทางการรับสงจะกําหนดตายตัวจากวงจร แตถาเปนแบบ RS485 นั้น จะ
สามารถสั่งควบคุมทิศทางการรับสงจากโปรแกรมไดวาจะใหทําหนาที่เปนฝายรับ หรือฝายสง อยางใดอยางหนึ่ง
ไดตามตองการได 
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การใชงานโปรแกรม w95s8535v5 และ w95mega163v1 สําหรับดาวนโหลดขอมูล 
กอนการ Download โปรแกรมทุกครั้งเราควรจะตรวจสอบใหแนใจกอนวา ไดจายไฟเลี้ยงใหกับบอรด

ถูกตองแลว ซี่งจะสังเกตไดจาก LED ตัวสีแดงจะสวางตลอดเวลาที่เราจายไฟใหกับบอรดทั้ง 3 รุน สําหรับไฟ
เล้ียงนั้นจะเปนไฟ AC หรือ DC ก็ไดแตควรจะมีระดับของแรงดันอยูระหวาง 9 -12 V และกระแส 800 –1000 
mA  ตอไปใหเราเชื่อมตอพอรตปริ๊นเตอร(Printer Port)เขากับบอรดทดลองดวยสายดาวนโหลด ET-PSPI โดยใน
การเลือกพอรตปริ๊นเตอรสําหรับการดาวนโหลดขอมูลนั้น หากคอมฯของทานมีพอรตปริ๊นเตอรมากกวา 1 พอรต
ทานก็สามารถเลือกพอรตปริ๊นเตอรพอรตใดก็ไดสําหรับตอสายดาวนโหลด เมื่อตอสายดาวนโหลดขอมูลเสร็จ
แลว ใหทานทําการเปดโปรแกรม w95s8535v5 ถาทานใช CPU เบอร 90S8535 แตถาหากทานใชเบอร 
ATmega163 ก็ใหทานเลือกเปดโปรแกรม w95mega163v1 ขึ้นมาแทน ซึ่งโปรแกรมทั้งสองตัวนี้เปนโปรแกรมที่
จะใชในการดาวนโหลดขอมูลลงไปที่ตัว CPU นั่นเอง โปรแกรม w95s8535v5 และ w95mega163v1 จะมีฟงก
ชั่นที่ทานตองทําการกําหนดกอนเริ่มทําการดาวนโหลดโปรแกรมดังนี้ 
 
ฟงกชั่น Lpt Port 

กอนการใชงานโปรแกรม w95s8535v5 และ w95mega163v1 ในครั้งแรกสุด เราจะตองทําการเลือก
พอรตปริ๊นเตอรที่เราจะใชในการดาวนโหลดโปรแกรมกอน โดยทานสามารถคลิกเลือกพอรตปริ๊นเตอรไดในกรอบ 
Lpt Port ซึ่งในกรอบนี้จะมีตัวเลือก 3 ตัวดวยกันนั่นคือ Lpt1, Lpt2 และ Lpt3 ซึ่งถาหากเราเลือกพอรตไมตรง
และพยายามที่จะทําการโปรแกรมขอมูล โปรแกรมจะแสดงกลองขอความผิดพลาดขึ้นมา วิธีแกก็คือใหเรากดปุม 
Ignore และโปรแกรมจะแสดงกลองขอความ “Error! Please check your CPU, power supply and printer 
port.”  ใหเรากดปุม OK จากนั้นก็เขาไปเลือกพอรตปริ๊นเตอรใหมใหถูกตอง โปรแกรมก็จะสามารถทํางานได  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปแสดง โปรแกรมดาวนโหลด w95s8535v5 
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      รูปแสดง โปรแกรมดาวนโหลด w95mega163v1 

 
ฟงกชั่น Delay  

ในการดาวนโหลดขอมูลลงไปที่ไมโครคอนโทรลเลอรนั้นเนื่องจากความเร็ว CPU ของคอมพิวเตอรของ
ผูใชงานมีความเร็วแตกตางกันไป ดังนั้นเพื่อใหการดาวโหลดขอมูลอยูในมาตรฐานความเร็วที่สามารถสื่อสารขอ
มูลกับไมโครคอนโทรลเลอรได เราจึงตองเพิ่มฟงกชั่น Delay ขึ้นมาเพื่อใหผูใชทําการปรับความเร็วในการสงขอ
มูลผานพอรตปริ๊นเตอรใหชาลง เราขอแนะนําใหทานทดลองดาวนโหลดขอมูลกอน หากการดาวนโหลดขอมูลไม
สามารถทําได ทานจึงคอยๆเพิ่มคาในชอง Bit กับ Byte ขึ้นไปเรื่อยๆจนมันสามารถดาวนโหลดขอมูลไดโดยไม
เกิดการผิดพลาด  
 
ฟงกชั่น Write Fuse(เฉพาะ w95mega163v1) 
 ฟงกชั่นนี้จะใชในการโปรแกรม Fuse bit ไบตสูงและไบตต่ํา สําหรับขอมูลรายละเอียดของ Fuse bit ทั้ง
สองไบตนี้ทานสามารถศึกษาไดจาก datasheet ของ CPU ฟงกชั่นนี้จะใชไดแตเฉพาะกับ ATmega163 เทานั้น 
เนื่องจาก CPU เบอรนี้มี Fuse bit หลายตัวที่จําเปนตอการทํางาน 
 เราควรจะทําการโปรแกรม Fuse Bits กอนการโปรแกรม Lock Bit และเมื่อเราทําการ Erase  CPU จะ
ไมมีผลกระทบใดๆ ตอ Fuse Bits ดังนั้นหากเราตองการเปลี่ยนสถานะของมันเราจะทําโดยการโปรแกรมคาใหม
ลงไปใหกับมันแทน 
 

***ขอสังเกตุ*** สําหรับการใช CPU เบอร ATmega163 ในครั้งแรกกับบอรดทั้ง 3 รุน เราขอแนะนําให
ทานทําการโปรแกรม Fuse Bits Low กอน โดยการพิมพ FA ลงไปที่ชอง Bits Low และกดที่ปุม Bits Low การ
กระทําเชนนี้ก็เพื่อใหเราสามารถใชคริสตอล 8 MHz ที่ตออยูภายนอกได แตหากทานไมทําการโปรแกรม Fuse 
Bits Low กอน แตนํามันไปใชงานเลย CPU จะใชสัญญาณนาฬิกาที่อยูภายในตัวมันซึ่งจะมีคาประมาณ 1 MHz   
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ฟงกชั่น Security 
 เราจะใชฟงกชั่นนี้เพื่อการโปรแกรม Lock Bit1 และ 2 (เมื่อLock Bit ใดถูกโปรแกรม Lock Bit นั้นจะมี
คาเปน 0) ซึ่งการโปรแกรม Lock Bit1 จะทําใหเราไมสามารถทําการโปรแกรมขอมูลลงบนหนวยความจําแบบ
แฟลชและEEPROMได สวนการโปรแกรม Lock Bit2 จะใหผลเหมือนกับการโปรแกรม Lock Bit1 และนอกจาก
นั้นแลวเรายังจะไมสามารถทําการ Verify หรือ อานขอมูลไดดวย 
 อยางไรก็ตามสถานะของ Lock bit1 และ 2 จะเปลี่ยนเปน 1( 1 ในที่นี้หมายถึงการไมไดถูกโปรแกรม) 
ทุกครั้งเมื่อเราทําการ Erase ขอมูล  
 
ปุม Open Hex File 
 กอนเราจะทําการเขียนโปรแกรมลงไปที่หนวยความจําแฟลชของไมโครคอนโทรลเลอรทุกครั้ง แนนอนที่
สุดเราจะตองมีขอมูลกอน ดังนั้นปุมนี้จะใชสําหรับนําขอมูลที่อยูในหนวยความจําถาวรเชน ฮารดดิสก มาเก็บไว
ในหนวยความจําชั่วคราวของเครื่องเพื่อรอที่จะถูกเขียนลงไปยังหนวยความจําแฟลชของไมโครคอนโทรลเลอร 
โดยขอมูลที่เราจะทําการอานเขามาเก็บในหนวยความจําชั่วคราวนี้จะตองอยูในรูปแบบภาษาเครื่องหรือที่เรา
เรียกวา Hex File(*.hex) เทานั้น สําหรับในคูมือการใชงานเลมนี้จะแนะนําการใชโปรแกรม AStudio4 AVR 
Assembler เพื่อทําการคอมไพลไฟลแอสเซมบลี (*.asm) ใหเปน Hex File อีกทีหนึ่ง 
 
ปุม Erase 
 ปุมนี้จะใชในการเคลียรหนวยความจําแบบแฟลชของ CPU ใหพรอมสําหรับการรับขอมูลใหม การ 
Erase ทุกครั้งจะทําใหหนวยความจําแบบแฟลชมีขอมูลเปน FFh ทั้งหมด และเราจะตองทําการ Erase ขอมูลทุก
ครั้งกอนการโปรแกรมขอมูลชุดใหมลงไป 
 
ปุม Blank 
  ปุมนี้จะใชในการตรวจสอบขอมูลที่อยูในหนวยความจําแบบแฟลชวามีขอมูลเปน FF หรือหนวยความ
จําถูกเคลียรทั้งหมดหรือไม หากพบวาขอมูลในหนวยความจําไมเทากับ FF มันจะแสดงกลองขอความเล็กๆ วา 
Not Blank ในการใชงานปกติเราไมมีความจําเปนตองใชปุมนี้ 
 
ปุม Program 
 ปุมนี้จะใชในการโปรแกรมขอมูลลงไปเก็บยังหนวยความจําแฟลชของ CPU  
 
ปุม Verify 
 ปุมนี้จะใชในการตรวจสอบวาขอมูลที่อยูในหนวยความจําแบบแฟลชของ CPU นั้นเปนขอมูลตัวเดียว
กันกับที่อยูในหนวยความจําชั่วความที่อยูบนเครื่องคอมพิวเตอรหรือไม ถาไมเทากันมันจะแสดงกลองขอความ
บอกวา Verify Error ดังนั้นปุมนี้จึงมีไวสําหรับการตรวจสอบขอมูลที่เราไดโปรแกรมลงไปวามันไดถูกโปรแกรมลง
ไปอยางถูกตองหรือไมนั่นเอง 
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ปุม Auto 
 ปุมนี้จะทําการโปรแกรมขอมูลแบบอัตโนมัติ โดยมันจะเริ่มทําตั้งแตการ Erase, Blank, Program และ
ส้ินสุดที่ Verify ดังนั้นกอนที่เราจะกดปุมนี้ เราควรจะมีขอมูลอยูในหนวยความจําชั่วคราวกอนโดยทําการ Open 
Hex File เพื่อเลือกโปรแกรมที่เราตองการทําการโปรแกรมจากนั้นจึงกดปุม Auto 
 ในการกดปุม Erase, Blank, Program, Verify หรือ Auto หากการทํางานไมเกิดการผิดพลาด ทานจะ
สังเกตเห็น LED สีเขียวกระพริบ ซึ่งจะเปนตัวแสดงใหเราทราบวาขณะนี้ขอมูลกําลังถูกสงผานสาย MOSI  
 สําหรับโปรแกรม w95s8535v5 และ w95mega163v1 นี้สามารถทํางานบนระบบปฏิบัติการ 
Windows 95/98/ME ไดทันที สวนบนระบบปฏิบัติการ Windows NT/2000/XP นั้นผูใชงานจะตองเปดการ
ทํางานของพอรตปริ๊นเตอรกอนทานจึงจะสามารถทําการดาวนโหลดขอมูลได ในการเปดการทํางานของพอรต 
ปร๊ินเตอรบน Windows NT/2000/XP นั้น เพื่อความสะดวกเราขอแนะนําใหทานใชโปรแกรม User Port ซึ่งอยูใน
แผน CD-ROM  
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แนะนําการใชโปรแกรม Astudio4 (AVR assembler) 
 สําหรับในหัวขอนี้เราจะอธิบายถึงวิธีการใชงานโปรแกรม Astudio4 เวอรชั่น 4.05 อยางงาย นั่นคือเรา
จะอธิบายเฉพาะการใช text editer และวิธีการคอมไพลโปรแกรมเทานั้น แตในสวนอื่นเชนการ debug 
program, chip simulator หากทานใดสนใจก็สามารถศึกษาไดจากเมนู Help ของ Astudio4 
 สําหรับโปรแกรมนี้มันสามารถทํางานไดบนวินโดวส 9x/ME/NT/2000/XP ดังนั้นจึงไมมีปญหาใดๆ
สําหรับผูใชระบบปฏิบัติการที่ตางชนิดกัน การติดตั้งโปรแกรมก็ทําไดไมยาก โดยใหทานคลายไฟล Astudio4(zip 
file)ออกมา จากนั้นก็รันไฟล setup.exe และก็ทําตามขั้นตอนที่แนะนําไปเรื่อยๆ จนการติดตั้งเสร็จสมบูรณ ซึ่ง
หลังการติดตั้งโปรแกรมนี้มันก็พรอมที่จะทํางานทันทีโดยเราไมตองเสียเวลารีสตารตเครื่องใหม 
System requirement 

- โปรแกรมนี้รันบนระบบปฏิบัติการ windows 9x/ME/NT/2000/XP 
- ความเร็วของ CPU Intel Pentium 200 MHz 
- ความละเอียดหนาจอไมควรต่ํากวา 800x600 pixels 
- แรม 64 MB 
- ที่วางฮารดดิสก 15 MB ขึ้นไป 

 
การสรางไฟลโปรเจ็กต(*.aps)และไฟลแอสเซมบลี(*.asm) 

เมื่อการติดตั้งเสร็จสมบูรณแลว และเราเปดโปรแกรมนี้ขึ้นมา เราจะพบหนาตาง Welcome to AVR 
Studio4 ดังนี้ 
 
 

 
 

รูปแสดง หนาตาง Welcome to AVR Studio 4  
หนาตางนี้จะมีไวสําหรับใหเราสามารถทําการสรางโปรเจ็กตไฟลใหมหรือสามารถเปดโปรเจ็กตไฟลที่มี

อยูแลวได โปรเจ็กตไฟลจะมีนามสกุลเปน .aps สําหรับหนาตางนี้มันจะแสดงเปนอันดับแรกของการเปด
โปรแกรมทุกครั้ง หากเราไมตองการใหมันแสดงหนาตางนี้ เราสามารถทําไดโดยการคลิกเมาส 1 ครั้งที่เช็คบ็อก 
Show this dialog on open ที่อยูทางดานลางซายมือของหนาตางนี้ เพื่อเอาเครื่องหมายถูกที่กาอยูในเช็คบ็อก
ออกไป ซึ่งในการเปดโปรแกรมครั้งตอไปทานจะไมพบหนาตางนี้อีก และการเปดหรือสรางโปรเจ็กตใหมเรา
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สามารถทําไดผานทางออปชั่น Project ที่อยูในเมนูบารแทน แตสําหรับการอธิบายในที่นี้เราจะใชหนาตางนี้ใน
การสรางโปรเจ็กตใหม โดยใหทานคลิกที่ปุม Create New Project ซึ่งทานจะพบกับหนาตางใหมดังรูปตอไปนี้ 

 
 
 
 
 
 
 
 
 
 
 
 

   รูปแสดง หนาตางที่ใชในการสรางโปรเจ็กตไฟล 
 

ในขณะที่ทําการสรางไฟลโปรเจ็กต โปรแกรมสามารถที่จะสรางไฟล .asm ซึ่งเปนไฟลโปรแกรมภาษา
แอสเซมบลีไดพรอมกันไปในตัวโดยการกาเครื่องหมายถูกที่เช็คบ็อก Create Initial File จากนั้นใหเราพิมพชื่อ
ไฟลโปรเจ็กตที่ชองขอความ Project Name ในตัวอยางเราจะใชชื่อไฟลโปรเจ็กต rs232 และในระหวางที่เรา
พิมพชื่อไฟลโปรเจ็กต เราจะสังเกตุเห็นวาโปรแกรมจะพิมพชื่อไฟลโปรเจ็กตลงที่ชองขอความ Initial File ไปดวย 
ซึ่งจะเปนการสรางไฟลโปรแกรม .asm (ไฟลแอสเซมบลี) และหากเราตองการใหโปรแกรมสรางไฟล .asm ที่มีชื่อ
ตางจากชื่อไฟลโปรเจ็กต เราก็สามารถแกไขชื่อไฟล .asm ไดที่ชองขอความ Initial File นี้ 

ขอควรระวังในการตั้งชื่อไฟลแอสเซมบลีตางจากชื่อไฟลโปรเจ็กตนั่นก็คือ เมื่อเราทําการคอมไพลแลว
ไฟลตางๆ ที่โปรแกรมทําการสรางขึ้นมามันจะตั้งชื่อตามชื่อไฟลโปรเจ็กตเชน ถาเราตั้งชื่อไฟลโปรเจ็กตเปน 
Testproject และเราตั้งชื่อไฟลแอสเซมบลีชื่อ rs232 หลังการคอมไพลเราจะไดไฟล Testproject.hex ดังนี้
เปนตน 

หากเราไมตองการใหมันสรางไฟลโปรแกรม .asm ขึ้นในขณะที่เราสรางไฟลโปรเจ็กต เราสามารถทําได
โดยการคลิกที่เช็คบ็อก Create Initial File เพื่อเอาเครื่องหมายถูกที่กาอยูออก สวนที่เช็คบ็อก Create Folder จะ
เปนการสรางโฟลเดอรขึ้นมาเพื่อเก็บไฟลโปรเจ็คไวนั่นเอง ถัดลงมาที่ชองขอความ Location จะเปนตําแหนงของ

ไฟลโปรเจ็คที่จะถูกนําไปเก็บ ซึ่งเราสามารถเลือกที่จะเก็บไฟลที่ใหมไดโดยการคลิกที่ปุม  ที่อยูทายชองรับ
ความหรือพิมพชื่อ path ลงไปเลยก็ไดเชนเดียวกัน สําหรับในตัวอยางนี้เราจะเก็บไฟลโปรเจ็กตไวที่ C:\My 
Documents\avr และทําการสรางไฟล .asm ขึ้นพรอมกับการสรางไฟลโปรเจ็กตดวย 

เมื่อทุกอยางถูกตองดีแลวก็ใหเราทําการคลิกที่ปุม Finish เพื่อจะเขาหนาจอ text editor สําหรับเขียน
โปรแกรมตอไป หนาจอที่เกิดขึ้นใหมหลังการกดปุม Finish แสดงไดดังรูปตอไปนี้ (ถาเรากดปุม Next โปรแกรม
จะใหเราเลือก paltform และ MCU ที่เราจะใชในการซิมมูเลตและ  debug โปรแกรม ตอไป) 



 
คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน CP-AVR V3.0/V3.0 EXP/V4.0 

ETT CO.,LTD. - 32 - WWW.ETT.CO.TH 

 

 
 

รูปแสดง หนาจอที่เกิดขึ้นหลังการกดปุม Finish  
 

 จากรูปขางบน จะประกอบไปดวยหนาตาง Work space ซึ่งมีไวสําหรับจัดการกับไฟลในโปรเจ็กตเชน
การ Add existing file, Remove File หรือ การ Set as Entry File เปนตน สวนหนาตางถัดมาคือ Text Editor มี
ไวสําหรับใหเราเขียนโปรแกรมลงไป และสุดทายเปนหนาตาง Output ที่ทําหนาที่แสดงขอความบอกใหเราทราบ
ถึงผลจากการคอมไฟลโปรแกรม ซึ่งหากทานไมพบหนาตางทั้งสามนี้ทานสามารถเปดมันขึ้นมาไดเอง โดยการ
เขาไปเลือกที่เมนู View  
 เมื่อเราทําการเขียนโปรแกรมลงไปที่ text editor เรียบรอยแลวก็ใหทําการบันทึกไฟลโดยการเลือกไปที่
เมนู File>save และทําการคอมไพลโปรแกรมโดยการกดปุม F7 หรือเลือกที่เมนู Project>Build หากเราเขียน
โปรแกรมถูกตอง โปรแกรมจะไมฟอง Error ที่หนาตาง Output แตหากเขียนโปรแกรมไมถูกตองมันจะฟอง Error 
หรือ Warning ก็ใหเราแกไขมันใหถูกตองและทําการคอมไพลใหมซึ่งจะทําใหไดไฟล rs232.aps, rs232.hex, 
rs232.lst, rs232.map, rs232.asm และ rs232.obj ขึ้นมา หากเราไมตองการไฟล .map และ .lst ใหเราเขาไปที่
เมนู Project>AVR Asembler Setup จากนั้นจะพบหนาตาง AVRAssembler  ใหเราคลิกเอาเครื่องหมายถูกที่
ชอง Map File กับ Lst File ออกและจากนั้นก็กดปุม Ok ก็เปนอันเสร็จส้ิน สําหรับไฟลนามสกุลตางๆ ดังที่เรา
กลาวมาขางตนทานสามารถเปดเขาไปดูเนื้อหาขางในไฟลไดดวยการเลือกไปที่เมนู File>Open File จากนั้นก็
เลือกไฟลที่ทานตองการเปดและกดปุม Open 

Work space Text Editor 

Output 
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     รูปแสดง หนาตาง AVRAssembler  
 

การเปดไฟลโปรเจ็กตและไฟลแอสเซมบลี 
 เมื่อเราตองการเปดโปรแกรมที่มีอยูแลวขึ้นมาแกไขเราสามารถทําไดโดยการคลิกเมนู Project>Open 
Project เพื่อเปนการเปดไฟลโปรเจ็กต(*.aps) หลังจากที่เราเปดไฟลโปรเจ็กตแลวจากนั้นก็คลิกเลือกไปที่
โฟลเดอร Assembler ที่อยูในหนาตาง Work space เราจะพบไฟล .asm ที่เราตองการแกไขอยูในนั้น แตถาหาก
เราเปดไฟลโดยใชเมนู File>Open File เราก็สามารถที่จะเปดไฟล .asm(หรือไฟลอื่นๆ ที่ text editor รองรับ) ได
เชนเดียวกัน แตเราจะไมสามารถทําการคอมไพลมันได เปนไดแตเพียงการแกไขและบันทึกเทานั้น อยางไรก็ตาม
การเปดไฟลโปรเจ็กต(*.aps) ดวยเมนู File>Open File นี้ก็สามารถทําไดและใหผลการทํางานเชนเดียวกับการ
เปดมันดวยเมนู Project>Open Project 
 
การ Add existing File, Remove File และ Set as Entry File 
 Add existing File ก็คือการเพิ่มไฟล .asm เขามาในโปรเจ็กต โดยเราสามารถทําได 2 วิธีดวยกันคือ
การเลือกไปที่เมนู Project>Add existing File จากนั้นก็ใหเราเลือกไฟล .asm ที่เราตองการนําเขามา สวนอีกวิธี
หนึ่งทําไดโดยการคลิกเมาสปุมขวาไปที่โฟลเดอร Assembler ที่อยูในหนาตาง Work space จากนั้นเราจะเห็น
หนาตางออปชั่นเล็กๆ ปรากฏขึ้นมาก็ใหเราเลื่อนเมาสไปคลิกเลือกที่ Add existing File จะทําใหเราสามารเลือก
ไฟล .asm ที่เราตองการได  
 Remove File จะทํางานตรงกันขามกับ Add existing File นั่นคือมันจะลบไฟล .asm ที่เราไมตองการ
ออกจากโปรเจ็กตไฟลของเรา เราสามารถ Removeไฟลไดโดยการคลิกเมาสปุมขวาเลือกไปที่ไฟลที่เราตองการ
ลบ จากนั้นจะปรากฏหนาตางขึ้นมาใหเราเลือกไปที่ Remove File form Project เพียงเทานี้ไฟลที่เราเลือกมันก็
จะถูกลบออกไปจากโปรเจ็กตที่เรากําลังทํางานอยู 
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 Set as Entry File จะเปนการเลือกไฟล .asm ที่อยูในโปรเจ็กตไฟลขณะนั้นใหมันพรอมที่จะถูก
คอมไพล ฟงกชั่นนี้จะมีความจําเปนมากเมื่อเรามีไฟล .asm หลายไฟลอยูในโปรเจ็กตเดียวกัน ซึ่งโปรแกรม 
Astudio4 นี้จะไมทําการคอมไพลไฟล .asm ทั้งหมดพรอมกัน แตจะเลือกคอมไพลเฉพาะไฟลที่โดน Set as 
Entry File เทานั้น เราสามารถรูไดวาไฟล .asm ตัวใดที่ถูก set ไวโดยการสังเกตไอคอนที่อยูหนาชื่อไฟลจะมีรูป
ลูกศรสีแดงหันหัวลงดังนี้  หรือดูไดจากรูปนี้  

 
รูปแสดง หนาจอที่เกิดจากการ Add existing File และหนาตาง Output ที่รายงานผลการ
คอมไพลโปรดสังเกตการ Warning (วงกลมสีเหลือง) ตางๆดวย ถึงแมการคอมไพลไมผิด
พลาดแตอาจจะมีผลตอการทํางานของ CPU ได 
 

สําหรับการ Set as Entry File สามารถทําไดโดยการคลิกเมาสปุมขวาเลือกไปที่ชื่อไฟลที่เราตองการ
คอมไพลจากนั้นจะปรากฏเมนูเล็กๆ ขึ้นมาใหเราเลือกไปที่ Set as Entry File ก็เปนอันเสร็จ 
 เราควรจําไวอยางหนึ่งวาหลังการคอมไพลแลวไมวาเราจะทําการคอมไพลไฟล .asm ตัวใดก็ตามในโปร
เจ็กตนั้น ไฟลเอาพุตที่โปรแกรมสรางขึ้นมานั้นจะมีชื่อตามชื่อไฟลโปรเจ็กตนั้นเสมอ มันจะไมมีชื่อไฟลตามไฟล 
.asm ที่ถูกคอมไฟล ดังนั้นเพื่อปองกันการสับสนทานอาจจะใหมีเพียงไฟล .asm เพียงไฟลเดียวอยูในไฟลโปร
เจ็กตแตละโปรเจ็กตก็ไดและตั้งชื่อใหทั้งสองไฟลนี้ตรงกัน 
 อีกอยางหนึ่งที่เราอยากจะใหทานสังเกต นั่นก็คือผลที่ไดจากการคอมไพลในแตละครั้งวาเปนเชนไรบาง
เชน ขนาดของไฟลที่คอมไพลไดมีขนาดเทาไรซึ่งบางทีเราเขียนโปรแกรมเพลินมันอาจจะมีขนาดโตกวาหนวย
ความจําที่จะเก็บมันก็ได หรือที่สําคัญอีกอยางหนึ่งก็คือขอความ Warning ที่โปรแกรมเตือนดังนี้ 
“C:\My Documents\avr\rs232.asm(92): warning: A .db segment with an odd number of bytes is 
detected. A zero byte is added.”  
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 หากทานใดเคยเลน AVR และใชฟงกชั่นที่เกี่ยวกับพอรตอนุกรม RS232 คงพอจะทราบดีวาบางครั้ง 
AVR มันก็ไมสามารถแสดงขอความที่อยูหลังบรรทัดนี้(บรรทัดที่แสดงขอความ Warning) ตอไปได ทั้งที่ขอความ
ยังไมส้ินสุด นั่นเปนเพราะวามันจะทําการเขียนขอมูลลงหนวยความจําโปรแกรมเปนทีละ word(2 ไบต) ดังนั้น
เมื่อขอความที่เราตองการจะเขียนลงบนหนวยความจํามันมีจํานวนเปนเลขคี่ มันก็จะเพิ่มเลข 0 เขาไปทายขอ
ความในบรรทัดนั้นๆ เพื่อใหครบจํานวนเปนเลขคูเสมอ  ทีนี้เมื่อเราเขียนโปรแกรมใหตรวจสอบขอความวาถาพบ
เลข  0 เมื่อใดก็ใหถือวาส้ินสุดขอความทันที ดังนั้นเมื่อโปรแกรมทําการอานและตรวจสอบขอมูลมาถึงไบตที่ 
AVR เพิ่มเลข 0 ขึ้นมาเอง โปรแกรมก็เขาใจวาเราตองการสิ้นสุดขอความที่บรรทัดนี้ดังนั้นจึงทําใหขอความที่
เหลือไมถูกตรวจพบนั่นเอง และวิธีแกงายๆ นั่นก็คือใหเราเพิ่มอักขระอะไรก็ไดเขาไปอีกตัวหนึ่งในบรรทัดนี้ยกเวน
เลข 0 เทานี้ก็สามารถแกการ warining ตรงนี้ได(เลข 0 ที่เรากําลังพูดถึงกันอยูขณะนี้ไมใชเลข “0” ที่เปนรหัส 
ASCII นะครับหากแตเปนเลข 0 ที่เปนเซตของเลขจํานวนเต็ม) 
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